
  

                                                                                        

mai



  

2 

ITALIANO 
Questo prodotto è coperto da garanzia Atlantis della durata di 2 anni. Per maggiori dettagli in merito  o per 
accedere alla documentazione completa in Italiano fare riferimento al sito www.atlantis-land.com. 
 
ENGLISH 
This product is covered by Atlantis 2 years warranty. For more detailed informations please refer to the web 
site   www.atlantis-land.com. 
For more detailed instructions on configuring and using this device, please refer to the online manual.   

 
FRANCAIS 
Ce produit est couvert par une garantie Atlantis  de 2 ans.  Pour des informations plus détaillées, référez-vous 
svp au site Web www.atlantis-land.com. 
 
DEUTSCH 
Dieses Produkt ist durch die Atlantis 2 Jahre Garantie gedeckt. Für weitere Informationen, beziehen Sie sich 
bitte auf Web Site www.atlantis-land.com. 
 
ESPAÑOL 
Este producto esta cubierto por Atlantis con una garantía de 2 años. Para mayor información diríjase a nuestro 
sitio Web www.atlantis-land.com. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.atlantis-land.com/
http://www.atlantis-land.com/
http://www.atlantis-land.com/
http://www.atlantis-land.com/
http://www.atlantis-land.com/
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AVVERTENZE 
Abbiamo fatto di tutto al fine di evitare che nel testo, nelle immagini e nelle tabelle presenti in questo manuale, 
nel software e nell'hardware fossero presenti degli errori. Tuttavia, non possiamo garantire che non siano 
presenti errori e/o omissioni. Infine, non possiamo essere ritenuti responsabili per qualsiasi perdita, danno o 
incomprensione compiuti direttamente o indirettamente, come risulta dall'utilizzo del manuale, software e/o 
hardware. 
Il contenuto di questo manuale è fornito esclusivamente per uso informale, è soggetto a cambiamenti senza 
preavviso (a tal fine si invita a consultare il sito www.atlantisland.it o www.atlantis-land.com per reperirne gli 
aggiornamenti) e non deve essere interpretato come un impegno da parte di Atlantis che non si assume 
responsabilità per qualsiasi errore o inesattezza che possa apparire in questo manuale. Nessuna parte di 
questa pubblicazione può essere riprodotta o trasmessa in altra forma o con qualsiasi mezzo, elettronicamente 
o meccanicamente, comprese fotocopie, riproduzioni, o registrazioni in un sistema di salvataggio, oppure 
tradotti in altra lingua e in altra forma senza un espresso permesso scritto da parte di Atlantis. Tutti i nomi di 
produttori e dei prodotti e qualsiasi marchio, registrato o meno, menzionati in questo manuale sono usati al 
solo scopo identificativo e rimangono proprietà esclusiva dei loro rispettivi proprietari. 
 
AVVERTENZE 
 Non usare il dispositivo in un luogo in cui ci siano condizioni di alte temperatura e umidità, il dispositivo 

potrebbe funzionare in maniera impropria e danneggiarsi. 
 Non usare la stessa presa di corrente per connettere altri apparecchi al di fuori del dispositivo in oggetto. Il 

prodotto va aperto solo quando è staccato dalla rete elettrica. 
 Non aprire mai l’housing del dispositivo (se non per inserire l’HDD e quando è scollegato dalla presa elettrica) 

né cercare di ripararlo da soli.   
 Se il dispositivo dovesse essere troppo caldo, emettere suoni o odori particolare spegnerlo immediatamente 

e rivolgersi a personale qualificato. 
 Non appoggiare il dispositivo su superfici plastiche o in legno che potrebbero non favorire lo smaltimento 

termico. 
 Mettere il dispositivo su una superficie piana e stabile. 
 Usare esclusivamente l’alimentatore fornito nella confezione, l’uso di altri alimentatori farà automaticamente 

decadere la garanzia. 
 Non effettuare upgrade del firmare utilizzando apparati/client wireless ma solo cablati. Questo potrebbe 

danneggiare il dispositivo ed invalidare la garanzia. 
 Usare il prodotto solo in ambienti INDOOR. 
 Non inserire nell'NVR alcun oggetto metallico. 
 Conservare la confezione con cura, va utilizzata in caso di problemi per rispedire in maniera sicura il prodotto 

ad Atlantis. 
 Nel dispositivo è preinstallata una batteria al litio da 3V, questa va sostituita quando (ad alimentazione 

assente) il dispositivo non mantiene più l’ora corretta. Scollegare l’apparato dalla presa elettrica e sostituire 
la batteria. 

 Lasciare almeno 10 cm liberi a lato dell’apparato e non ostruire mai le feritoie laterali e superiori. Il 
dispositivo contiene un HD che genera calore. La mancata dispersione porterebbe a problemi di 
surriscaldamento. 

 Ogni collegamento va fatto solo ed esclusivamente a dispositivo spento. 
 Per uso interno. 
 Non utilizzare il prodotto nel caso di cavo danneggiato. 
 Portare presso un centro abilitato alla riparazione. 
 Non è un giocattolo. 
 Tenere fuori dalla portata dei bambini. 
 L’apparecchio non deve essere utilizzato da persone con problemi fisici ridotti, sensoriali o ridotte capacità 

mentali o mancanza di esperienza e conoscenza, a meno che non siano sotto la supervisione di persona 
adulta o che non siano state fornite adeguate istruzioni. 

 Valori di targa per l’adattatore fornito con A11-NVR1600-AK [Input: 100-240VAC, 50/60Hz, 0,7A Max 

/Output: 12,0VDC 2,0A 24,0W Max      ] 
 

http://www.atlantisland.it/
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Tutte le condizioni di utilizzo, avvertenze e clausole contenute in questo manuale e 
nella garanzia si intendono note ed accettate. Si prega di restituire immediatamente 
(entro 7 giorni dall’acquisto) il prodotto qualora queste non siano accettate. 

Atlantis invita a visitare il sito web www.atlantis-land.com alla relativa pagina di 
prodotto per reperire manualistica e contenuti tecnici (aggiornamenti driver e/o 
funzionalità, utility, support note) aggiornati. 

Per usufruire delle condizioni di garanzia migliorative associate al prodotto 
(Fast Swap, On Site e On Center) è opportuno provvedere alla 
registrazione dello stesso sul sito www.atlantis-land.com entro e non oltre 
15 giorni dalla data di acquisto. La mancata registrazione entro il termine 
di sopra farà sì che il prodotto sia coperto esclusivamente dalle condizioni 
standard di garanzia. 

Ogni dispositivo Outdoor (IP Camera), non destinato all’utente finale, è 
garantito 12 mesi.  
Tutti i malfunzionamenti dovuti a infiltrazioni di acqua/umidità non 
saranno coperti da garanzia superato questo periodo di 12 mesi. 

L’utilizzo di dispositivi in grado di catturare immagini, video o voce potrebbero essere 
regolamentati o completamente proibiti in talune giurisdizioni. Potrebbe essere 
richiesta un’autorizzazione. 
Atlantis non garantisce in alcun modo che i propri prodotti siano utilizzati in 
conformità con le leggi locali ed inoltre non può essere ritenuta responsabile per un 
uso improprio di tali dispositivi. 
È opportuno inoltre segnalare chiaramente la presenza di dispositivi capaci di 
catturare immagini, video o voce. 
Si ricorda infine di rispettare attentamente la legislazione vigente riguardante le 
modalità di conservazione dei contenuti video ripresi. 

Utilizzare solo FW originali scaricati dal sito www.atlantis-land.com alla pagina di 
prodotto specifica. Altri FW possono bloccare il dispositivo e comunque INVALIDANO 
la garanzia. NESSUN SUPPORTO VERRA’ FORNITO. 

SUPPORTO OFFERTO 
Per qualunque altro problema o dubbio sul funzionamento del prodotto, è possibile 
contattare il servizio di assistenza tecnica Atlantis tramite l’apertura di un ticket on-
line sul portale http://www.atlantis-land.com/ita/supporto.php. Nel caso non fosse 
possibile l’accesso al portale di supporto, è altresì possibile richiedere assistenza 
telefonica al numero 02/ 93.55.00.66 (consultare il sito per verificare gli orari in 
cui il servizio viene erogato).  Per esporre eventuali richieste di supporto prevendita 
o richieste di contatto, si invita ad utilizzare gli indirizzi mail info@atlantis-land.com 
oppure prevendite@atlantis-land.com.  

Questo manuale è stato redatto per la versione di FW: 
NVR_MC6830_16CH_BD_V5_V20.1.35.1_E00020347 (visualizzabile in 
Sched Riavvio->Dispositivo) compilata il 29/10/2020. 

 
 

http://www.atlantis-land.com/
http://www.atlantis-land.com/
http://www.atlantis-land.com/ita/supporto.php
mailto:info@atlantis-land.com
mailto:prevendite@atlantis-land.com
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La ringraziamo per aver scelto un apparato della famiglia NVR Ultraplex, la via più semplice per la 
videosorveglianza IP. Questo manuale permette di mettere rapidamente il sistema in funzione (nei capitoli 
1,2,3) mentre nei successivi capitoli si spiega nel dettaglio il funzionamento dell’apparato. Conservare per 
futura referenza. 

1. PANORAMICA DI PRODOTTO 

A11-NVR1600A-K 
NVR 1600 AK è un registratore digitale che permette sia la visualizzazione in diretta, sul monitor collegato (In 
VGA o tramite HDMI anche in modalità 4K) sino a 16 flussi video ripresi dalle IP Camera, che la registrazione 
(utilizzando il codec H.264/H.265 sul disco da 3,5” interno) in modalità continua, schedulata, su evento 
(Motion Detection/Allarme) o forzata. La CPU di ultima generazione, permettendo la registrazione di 16 canali 
a 8MP (3840x2160, max 100Mbps) ciascuno a 25 fps, garantisce una qualità video (registrazione o 
riproduzione) senza precedenti. NVR 1600 AK, tramite l'interfaccia di Gigabit Ethernet, può essere collegato 
direttamente alla LAN ed essere gestito e controllato anche da remoto, in maniera semplice ed intuitiva in 
qualunque momento e luogo, tramite un PC o portatile collegato in Internet (o Intranet) utilizzando un 
qualsiasi browser (Internet Explorer) web o su sui è installato il CMS(Windows), oppure da piattaforme mobili 
quali iPhone, iPad ed Android (le applicazioni sono gratuite). La funzionalità P2P permette la visione remota 
senza la necessità di dover configurare altri apparati, è sufficiente scansionare il QRcode del prodotto per 
poter visualizzare e controllare (live/playback e PTZ) l'NVR. NVR 1600 AK supporta lo standard ONVIF 2.2 per 
una larga interoperabilità con le IP Camera presenti nel mercato ed è inoltre interfacciabile con IP camera 
PTZ, con 4 sensori esterni e può controllare 1 Sirena (o diversi apparati) esterna. Queste caratteristiche, 
unitamente alla moltitudine di client per servizio DNS dinamico inclusi, rendono NVR lo strumento ideale per 
il monitoraggio/videosorveglianza sia locale che remoto. 
Compatibile con tutte le telecamere della famiglia UltraPlex e IP Facile. 

1.1 REQUISITI DI SISTEMA (WEB)  

Prima di procedere con l’installazione del prodotto verificare di disporre dei seguenti requisiti: 
 Protocollo TCP/IP installato  
 Web browser, come Microsoft Internet Explorer 6.0 o successivi (Active X, per configurazione e Live View), 

Chrome/FireFox/Edge (solo configurazione) 
 CPU: Intel Celeron CPU E3400 @2.6GHz o superiori 
 Scheda Grafica: 64 MB RAM (o equivalente) 
 Windows 7, 8, 10 

 

Solo su Internet Explorer, previa installazione del plugin, è possibile 
visualizzare il flusso video. 

Questo guida rapida è stata redatta per molteplici apparati. Talune caratteristiche 
potrebbero essere non presenti in tutti modelli. 

L'aspetto di alcuni accessori potrebbe differire leggermente da quelli mostrati 
nelle fotografie della scatola/manuale/scheda tecnica. 

 

1.2 CONTENUTO DELLA CONFEZIONE 

Prima dell’utilizzo, verificare che la scatola contenga i seguenti elementi: 

 NVR 1600-AK  
 Guida Rapida (Italiano, Inglese). Si raccomanda di controllare online gli aggiornamenti. 
 Mouse USB 
 Alimentatore AC-DC (12V@2.0A) 
 Coupon di Garanzia  
Nel caso in cui il contenuto non sia quello elencato sopra, contattare il proprio rivenditore 
immediatamente. 
 

mailto:12V@2.0A
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1.3 INSTALLAZIONE DEL DISCO   

 Allentare, tramite un apposito cacciavite, le viti di bloccaggio poste ai lati (1 vite per lato) e nella parte 
posteriore (2/3 viti).  

 Rimuovere delicatamente la copertura. 
 Posizionare il disco facendo attenzione a non danneggiare il cablaggio esistente. Collegare il cavo dati ed il 

cavo di alimentazione al disco. 
 Installare l’HD sulla staffa e fissarlo saldamente con le viti (sono incluse 4 viti per il fissaggio).  
 Controllare che TUTTI e 2 i connettori siano saldamente collegati, chiudere la copertura e avvitare 

nuovamente le viti. 

 

L’HDD va installato mentre il sistema è spento e non collegato ad alcuna fonte di 
alimentazione.  Non tutti i dischi potrebbero funzionare correttamente.  
Il sistema supporta dischi sino ad un massimo di 4TB (sia da 3,5” che 2,5”). 
Non istallare SSD. 

1.4 CABLAGGIO NVR 

Collegare a questo punto all'NVR nell’ordine: 
 le IP Camera (direttamente alle  porte PoE mode B di un apposito Switch).  Si raccomanda l’utilizzo di 

camera Atlantis UltraPlex o IP Facile. Camere non ONVIF non saranno supportate se non tramite il protocollo 
RTSP. 

 il mouse fornito. 
 il cavo di rete, per la connessione alla LAN  (switch/Router) (opzionale). 
 cavo HDMI/VGA (non incluso) per la connessione ad un monitor. 
 cavo di alimentazione dall’alimentatore all’NVR. 
Solo a questo punto, quando TUTTI i collegamenti sono stati fatti, prima di collegare 
l’alimentatore alla rete elettrica, controllare nuovamente tutti i cablaggi. 
Collegare l’alimentatore alla presa elettrica. 
Segue un esempio tipico di cablaggio. 

 

Le IP Camera Atlantis, a seconda del modello, possono essere alimentate nelle seguenti 
modalità: 
  [IP Camera con PoE] Direttamente tramite il cavo di rete se connesse ad uno switch 

PoE. Si raccomanda l’utilizzo di uno Switch PoE mode A/B. Atlantis consiglia i modelli 
A02-F5PoE4-A, A02-F9PoE8-A e A02-F18PoE16-A. 

 [IP Camera] Tramite jack, connesse ad un alimentatore (12V@1A). Si raccomanda il 
codice A02-Adapter1. 

 [IP Camera] Tramite A02-Splitter1 connesso ad uno switch/NVR PoE.  
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2.  Analisi Dispositivo 

 

 

Talune immagini riportate in questo documento potrebbero essere leggermente diverse 
dal prodotto acquistato.  
 

 

2.1 Pannello Frontale  

 
LOGO/BOTTONE SIGNIFICATO 

PORTE USB 
Porta USB host ( ) cui collegare il mouse.  
In tutti gli NVR sono presenti 2 porte USB da utilizzarsi per effettuare il 
backup dei dati e/o per aggiornamento del firmware e per la connessione 
del mouse.  

LED 

Sono presenti diversi LED di stato: 
 HDD: Blu quando il disco è in uso. 
 NET: Acceso Verde quando il link Ethernet è attivo. 
 PWR: Acceso Rosso fisso quando l'apparato è operativo. 

 

 

Scaricare il manuale online aggiornato per avere maggiore informazioni sull’utilizzo 
del dispositivo.  
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2.2 Pannello Posteriore 

 
N° FUNZIONE SIGNIFICATO 

1 
Plug 
Alimentazione 

Connettere il plug di alimentazione. Utilizzare solo l’alimentatore 
fornito a corredo.   
I valori di targa del dispositivo sono: 12,0VDC 2,0A 24,0W 

2 
Porta USB 
(posteriore) 

Utilizzare questa porta USB per connettere una periferica di 
memorizzazione esterna (HDD, memory stick). 
Collegare invece alla porta anteriore un mouse. 

3 AUDIO IN/OUT 
Connettore RCA per uscita/ingresso AUDIO. 
NON SUPPORTATI. 

4 Uscita  HDMI/VGA 

Collegare ad uno schermo esterno (interfaccia HDMI/VGA).  
Le risoluzioni supportate, su VGA, vanno da 1024x768 sino a 
1920x1080. 
L’uscita HDMI invece supporta sino a 4K. 

5 Porta Ethernet 
Utilizzare questa porta Ethernet Gigabit (interfaccia RJ45) per 
collegare il dispositivo alla LAN.  

6 ALARM IN/OUT 

4x Alarm OUT: 
L'uscita non va mai connessa ad un carico con alto assorbimento, al 
massimo 1A. Corrente ad alto amperaggio potrebbe danneggiare il 
circuito relay. Il carico va ad ogni modo alimentato. In caso si desideri 
pilotare carichi con elevato assorbimento si raccomanda di utilizzare 
circuiti di isolamento opportuni. 
4x Alarm IN: 
Il circuito in ingresso è solitamente un circuito che cambia di stato 
(interruttore, PIR) che può essere utilizzato per pilotare una serie di 
eventi quali: Avvio registrazione, Invio Mail, Segnalazione Acustica, 
Segnalazione Ottica e Chiusura Alarm OUT. 

 
Operazione col Mouse 
È possibile utilizzare il mouse fornito, o un qualunque mouse USB, per navigare tra i menù dell'NVR. 

Funzione Significato 

Tasto sinistro del Mouse Nel menu di OSD, cliccare il tasto di sinistro per selezionare e 
editare. 

Tasto destro del Mouse 
Nel modo di visualizzazione in live, cliccare il tasto destro per 
visualizzare la barra di pop-up del menu. 

Doppio Click sul tasto 
Sinistro del mouse 

Fare un doppio click nell'immagine in live di qualsiasi canale per 
passare alla visualizzazione monocanale.  
Fare un doppio click sulla visualizzazione monocanale, la 
visualizzazione tornerà alla modalità multicanale. 

 

Tastiera Virtuale (Mouse) 

Quando si utilizza il mouse, è possibile immettere determinati valori per mezzo della tastiera virtuale sullo 
schermo. Cliccando su un campo dove è richiesto l’inserimento di un testo il sistema visualizzerà una tastiera 
virtuale a schermo con cui scrivere i testi. 
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 Cliccare su SHIFT per passare alla modalità alfabetica Maiuscola, cliccare nuovamente per passare 
alla modalità alfabetica Minuscola e poi nuovamente per tornare alla modalità numerica. 

 Cliccare su #+= per passare alla tastiera coi simboli. 
 Cliccare su DEL per cancellare l’ultimo valore immesso. 
 Cliccare su ENTER per uscire dalla modalità tastiera. 
Quando i tasti sono selezionati il sistema evidenzierà il tasto contornandolo in rosso. 
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3.  Avvio del l'NVR 

3.1. Schermata di avvio dell'NVR  

Dopo aver seguito scrupolosamente i paragrafi precedenti e dopo aver collegato il sistema alla rete elettrica, 
durante la fase di boot, verrà visualizzata la seguente schermata. 

 
Dopo un paio di minuti il sistema sarà operativo. Potrebbe essere visualizzato un errore sul disco (non 
riconoscimento del disco o assente). Proseguire per avvira la configurazione. Nel primo menù visualizzato è 
possibile selezionare la lingua che verrà utilizzata dal dispositivo. Cliccare su Uscire per proseguire in Italiano 
o selezionare l’idioma desiderato nella combo box cliccare su Applica.  
A questo punto verrà visualizzata la schermata di Accesso Utente (User Login). Effettuare adesso, dopo 
aver scelto la lingua di default (ENG, ITA), il Login (admin, atlantis) e cliccare su Accesso(Login). 
Verrà visualizzata una finestra in cui il sistema suggerisce il cambio della password. Cliccare su Modifica 
Dopo(Modify Later) per proseguire. 
Partirà la Configurazione Assistita (Boot Wizard). 
Verrà visualizzata la schermata di Setup Data e Ora in cui è possibile cambiare la Fuso Orario(Zona) 
(Time Zone), Formato data (Date Format) e Data/Ora (Date Time). Deselezionare, in basso, la voce 
Abilitare Wizard per disabilitare la configurazione assistita al prossimo riavvio.  
Cliccare su Avanti (Next) per proseguire. 
Verrà visualizzata la schermata di Setup Network, dove è possibile scegliere impostare l’indirizzo IP (via 
DHCP, scelta consigliata, o digitarlo manualmente).  Cliccare su Avanti (Next) per proseguire. 
[Opzionale] Selezionare il disco e cliccare su Formatta[Format] per formattare il disco rigido (questo 
processo ne cancellerà irrimediabilmente l’intero il contenuto). Questo riavvierà l’NVR. Cliccare su Seguente 
(Next) per proseguire. 
Verrà adesso visualizzata la schermata Aggiungere Camera (Add Camera). Cliccare sul bottone 
Ricerca(Add), dopo qualche secondo verrà visualizzata la schermata Rileva Dispositivo (Device Search) 
con l’elenco delle IP Camera (Onvif) rilevate. In caso di problemi selezionare Filtra=Onvif e Privato e 
cliccare nuovamente su Ricerca (Search). 
Spuntare le IP Camera che si desidera aggiungere e cliccare su Aggiungi(Add). 

Le IP Camera con l’icona blu [ ], nel campo Link, saranno visualizzate direttamente mentre quelle con 

l’icona gialla [ ]dovranno essere poi configurate (cliccare sull’icona CAMBIA corrispondente e configurare i 
parametri di accesso corretti). 
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Cliccare su Avanti (Next) per proseguire. 
Verrà adesso visualizzata la schermata per il cambio della password.  
Cliccare su Terminare(Finish) per finire la wizard senza cambiare la password. 

 

È possibile cambiare la lingua utilizzata nell’OSD. Andare in [ ]Sistema ->Generale 
e poi selezionare nella combo box Lingua l’idioma desiderato. Cliccare Applica. Il 
dispositivo effettuerà un reboot. 

Per cambiare la modalità di visualizzazione effettuare il Login. Può essere richiesta la 
username/password (le credenziali di accesso di default sono: admin, atlantis). Cliccare 
il tasto destro del mouse per far apparire la barra con i menu nella parte alta dello 

schermo, cliccare su [ ]Anteprima e poi nella parte bassa all’estrema destra dello 
cliccare sulla modalità di visualizzazione preferita. 

Si raccomanda di utilizzare almeno una risoluzione di 1920x 1080 al fine di poter leggere 
correttamente le informazioni a video. Risoluzioni inferiori possono causare il 
troncamento di alcune parole (nelle voci del menu o descrizioni) e rendere di non facile 
utilizzo il dispositivo. 

Taluni menu a video potrebbero essere leggermente diversi (l’OSD mostrato è stato 
infatti ripreso dal modello ad 8 canali). 

Cliccando Uscita(Exit) è possibile, previo conferma, terminare la configurazione 
assistita in qualsiasi momento. 

È opportuno considerare che alcune camere IP in standard ONVIF potrebbero non essere 
supportate. Camere IP non ONVIF certamente non saranno supportate. 

Per formattare il disco inserito (2,5” o 3,5”) accedere in Storage->Dispositivo di 
Storage, spuntare il disco e cliccare su Formatta(Format). 

L’utilizzo di dispositivi in grado di catturare immagini, video o voce potrebbero essere 
regolamentati o completamente proibiti in talune giurisdizioni. Potrebbe essere richiesta 
un’autorizzazione. Atlantis non garantisce in alcun modo che i propri prodotti siano 
utilizzati in conformità con le leggi locali ed inoltre non può essere ritenuta responsabile 
per un uso improprio di tali dispositivi. È opportuno inoltre segnalare chiaramente la 
presenza di dispositivi capaci di catturare immagini, video o voce. 
Si ricorda infine di rispettare attentamente la legislazione vigente riguardante le modalità 
di conservazione dei contenuti video ripresi. A tal fine è opportuno, salvo nuove 
normative a cui si invita ad attenersi, utilizzare i seguenti settaggi: 
 Sistema->Generale->Modalità Registrazione=Sovrascrittura e Giorni 

Conservati=1 

Per aggiungere Camere in un momento successivo, cliccare su [ ]Canale->Camera 
e poi su 

 Aggiunta Manuale: È possibile forzare una IP camera. 
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 Ricerca (nella parte bassa): La scansione viene effettuata nella stessa 
classe cui appartiene l’indirizzo IP dell’NVR, per effettuare una scansione 
multiclasse selezionare nella combo box Filtra(Filter) la voce Rete 
Multisegmento (Multi Net Segment) e cliccare nuovamente su Ricerca 
(Search). Evidenziare la camera e cliccare su Aggiungi. Alcune IP Camere 
Onvif potrebbero incontrare problemi di compatibilità (il Link potrebbe essere 
di colore rosso). In caso di problemi questi potrebbero essere risolti cliccando 
rispettivamente sulle icone Cambia(Edit) della IP Camera in questione 
(password di accesso/lo streaming usato e la porta Onvif).  

In [ ]Canale- Manin Stream/Sub Stream è possibile cambiare, tra le altre cose, 
la risoluzione dei flussi (main, substream), il bitrate(Kb/s) e il Frame Rate.  
In caso di ulteriori problemi prendere in considerazione IP Camere Ultraplex o IP Facile 
di Atlantis. 

La funzionalità Drug’n’Drop permette di spostare liberamente i flussi video tra una 
finestra ed un’altra semplicemente tenendo premuto il tasto sinistro del mouse e 
trascinando il video nella finestra desiderata. 

Si raccomanda il cambio della password di accesso.  
In Sistema->Utente selezionare l’utente admin, cliccare su Modificare. 
Digitare la password in uso e cliccare su Conferma. 
Immettere la nuova password (2 volte, di almeno 8 caratteri con almeno un numero e 
una lettera).  
 Impostare se si desidera la Gesture di accesso. 
 Rispondere a 3 domande (ed annotare le risposte). 
 Cliccare su Chiave di esportazione, dopo aver inserito una chiavetta USB 

formattata. Il sistema risponderà visualizzando la scritta “esportazione 
completata!”. 

Conservare gelosamente queste modalità di recupero. L’accesso al sistema 
NON è recuperabile senza queste informazioni. Il recupero presso il centro di 
assistenza è interamente a carico del cliente. 
Qualora questa venga dimenticata cliccare su Password Dimenticata per effettuarne 
il recupero. 
Sono presenti 3 modalità di recupero: 
 Rispondi alle domande impostate 
 Chiave Importazione 
 Password Dinamica (non utilizzabile dall’utente finale) 

Qualora non si riesca ad effettuare il recupero utilizzando queste modalità l’NVR va inviato 
al centro assistenza (a carico del cliente). 

 

Il dispositivo può controllare 16 camere IP della famiglia Ultraplex. 
Queste camere IP dovranno avere un indirizzo IP nella stessa classe dell’NVR. 
Per aggiungere una camera cliccare su Anteprima/Preview, cliccare su un canale 
video vuoto (il contorno diventerà rosso) e cliccare poi sul tasto +. Partirà la ricerca delle 
camere connesse.  
Evidenziare la riga della camera che si desidera aggiungere e cliccare sul bottone 
Aggiungi. 
Dopo qualche secondo il video dovrebbe essere mostrato. 
Ripetere l’operazione per ogni camera da aggiungere. 

I flussi video verranno mostrati in Live (cliccare 2 volte il tasto sinistro su un canale per ottenere la 
visualizzazione a schermo intero, effettuando nuovamente un doppio click il dispositivo passerà alla modalità 
multicanale). 
Nella parte alto a destra verrà riportata, in overlay, la data e l’ora del dispositivo. 
Nella parte bassa, di ciascun flusso video, è presente una barra riportante le seguenti informazioni. 

[ ]: Registrazione Attiva. 
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[ ]: Rilevazione movimento attiva (Motion Detection) 

3.2 Main Menu 

Una volta effettuato il LOGIN è possibile avere accesso al menu nella parte superiore (cliccare il tasto destro 
se il sistema è in modalità Anteprima a schermo intero).   
Spostare il mouse sull’icona desiderata e cliccare il tasto sinistro: 

 [ ]Preview: Permette di visualizzare i flussi video ricevuti dall’NVR. È possibile passare allo schermo 
intero o col numero di canali desiderato, cliccando sulle icone nella parte bassa a destra. Le altre icone 
permettono invece di conoscere dettagli sullo stato di sistema. 

 [ ]Riproduzione: Permette di accedere alla finestra di riproduzione dei video registrati sull’HDD. 

 [ ]File Management: Consultare il capitolo seguente. 

 [ ]Smart Analysis: Consultare il capitolo seguente. 

 [ ]Canale: Permette la configurazione dettagliata delle camere connesse e visualizzare la potenza POE 
residua ed impegnata. 

 [ ]Storage: Permette di accedere alla finestra di controllo delle registrazioni. Qui è possibile impostare, 
per canale, la modalità (nessuna registrazione in grigio, schedulata in verde o su rilevazione del movimento 
in giallo, rosso su allarme ecc.). 

 [ ]Sistema: Permette la configurazione avanzata dell’NVR. In questa sezione è attivabile la 
configurazione della registrazione su rilevazione (Movimento o Allarme). 

 [ ]Sched. Riavvio: Permette la visualizzazione dello stato di funzionamento dell’NVR e di effettuarne il 
reset, aggiornamento, salvataggio configurazione e riavvio.   

 [ ]Allarme: Permette la visualizzazione i vari allarmi.   

 [ ]Backup: Permette la visualizzazione dello stato dei backup in corso. 
 

 

Talune Voci possono essere, a causa della lunghezza intrinseca e/o risoluzione di 
visualizzazione e/o carattere utilizzato, tagliate e/o incomplete. Ci scusiamo in anticipo 
per i disagi che questo potrà comportare. 
Per disabilitare il Logout automatico digitare MAI alla voce Disconnessione 

Automatica in [ ]Sistema ->Generale. 

 

 

Rilevazione del movimento con camere UltraPlex. 

 [ ]Storage->Registra, selezionare il canale, spuntare abilita ed impostarlo 
su Ril Movimento(giallo).  

 [ ]Sistema->Evento Normale->Ril Movimento selezionare il canale e 
spuntare abilita e poi Impostare Area (solo l’area sotto la griglia rossa è 
analizzata) e la sensibilità. Impostare poi l’intervallo di validità (Schedulazione 
Allarmi) e impostare poi, in Azione Linkage, la registrazione (registrazione del 
canale). Confermare cliccando su Applica. 

Nella schermata di Preview verrà visualizzata l’icona [ ] ad ogni rilevazione di 
movimento. 
Opzionalmente è possibile attivare anche l’allarme acustico, invio di una mail e l’uscita 
allarme (chiusura del contatto). 
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3.3 Configurazione dell'APP per iOS/Android 

 Scaricare e installare sul proprio dispositivo l’applicazione BitVision [ ]. 
 Al primo avvio, una volta accettati i termini di utilizzo e abilitati gli accessi richiesti dall’app, è necessario 

creare un account cui è possibile associare diversi dispositivi. Toccare su Registrati/Register e digitare 
la mail, la password (2 volte, almeno 6 caratteri) e toccare su Send Email Code. Completare copiando il 
valore numerico, ricevuto all’indirizzo mail specificato, nel campo captcha. Toccare poi su 
Registrati/Register. Dopo qualche secondo la scritta Registrazione avvenuta/Successfull 
Registration confermerà l’avvenuta creazione dell’account. 

 
 Lanciare l’applicazione e digitare le credenziali prima create e toccare su Login.  
 Entrare nell'interfaccia dell’NVR, effettuare il Login e cliccare su Sistema->Avanzato->P2P e spuntare la 

voce Abilita P2P.  La voce Stato, dopo qualche secondo, dovrà essere in linea. In caso contrario 
controllare la configurazione dell’indirizzo IP dell’NVR. 

 Toccare su [ ], toccare su [ ] e toccare poi su SN Add, scansionare il QR code posto sullo 
sticker/scatola e quindi, dopo aver digitato il nome (un massimo di 20 caratteri, esclusi caratteri speciali) da 
assegnare al dispositivo e la username/password di accesso (admin, atlantis), digitare il valore captcha 
(posto sempre sullo sticker/scatola) e selezionare il gruppo (my Devices) toccare su fatto/Done. Dopo 
qualche secondo l’App confermerà l’avvenuta associazione del dispositivo all’account. La richiesta del 
captcha potrebbe non essere obbligatoria. 
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 Toccare su [ ], toccare su Real Time e poi in uno degli schermi, selezionare il dispositivo ed i canali da 

visualizzare spuntandoli e toccare infine su Fatto/Done. Toccare sull’icona [ ] 
per passare alla modalità multiview desiderata (sino a 16 in iOS e Android). Toccare 2 volte sul canale per 
passare allo streaming a schermo unico. Quando è visualizzato un solo canale è possibile scegliere, banda 
permettendo, lo streaming da visualizzare (Fluido, BD, HD). Toccare sul video nuovamente per avere 
accesso ai controlli di registrazione (del flusso evidenziato dal contorno giallo o di quello in modalità a 

schermo unico) della diretta [ ], cattura immagine [ ], controllo PTZ [ ], chiusura preview 

singola/totale[ / ]. I file catturati sono salvati nello smartphone, per visualizzare toccare su [ ], 

poi su [ ] e poi su Galleria. 

 

 Toccare su [ ], poi su [ ] per aggiungere un NVR al proprio account o per, una volta 
selezionati, cambiare nome e/o gruppo di appartenenza o rimuovere i vari dispositivi connessi dal profilo. 
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 Toccare su [ ], poi su [ ] per uscire dall’APP (verrà richiesta un’ulteriore conferma). 

 

L’ASSOCIAZIONE/RIMOZIONE di un dispositivo ad/da un account viene anche segnalata 
con l’invio di una mail (dal server BitVision all’indirizzo dell’account, contenente il seriale 
del dispositivo). 

Un dispositivo (IP Camera/NVR) può essere associato ad uno ed un solo 
account (mail, password) configurato nell’app BitVision. 
Conservare con cura le credenziali dell’account (mail, password). Senza queste non è 
possibile RIMUOVERE un eventuale dispositivo associato e pertanto tale dispositivo non 
sarà collegabile ad un altro account. 
L’account può essere utilizzato su diversi smartphone. 

È inoltre possibile accedere al dispositivo via APP tramite accesso diretto (senza server 
P2P). Si consulti il paragrafo seguente. 

In caso di problemi nella scansione (luci al neon, schermo a bassa risoluzione o 
riflettente) è possibile scansionare il QR Code posto sull’etichetta del prodotto. In caso i 
problemi di lettura persistessero toccare su Input e digitare il Seriale riportato sotto il QR 
Code (Sistema->Avanzato->P2P) e proseguire poi come da istruzioni 
precedentemente riportate. 

Entrare nell'interfaccia dell’NVR, effettuare il Login e cliccare su Sistema->Avanzato-
>P2P.  La voce Stato deve essere in linea (ovviamente Abilita P2P è spuntato). 

È opportuno, quando lo smartphone cambia modalità di accesso ad internet, chiudere 
l’applicazione e riavviarla. 

La funzionalità Playback via APP permette la riproduzione esclusivamente dei contenuti 
video registrati nell’HDD dell’NVR in modalità schedulata/evento. 

 
 

 

Il PUSH NOTIFICATION è una funzionalità in test. Non è stata per questo 
aggiunta come caratteristica supportata dal prodotto (non è pertanto garantito il 
corretto funzionamento, delay di servizio e supporto). 
Per utilizzarla abilitare il Motion Detection sulla camera UltraPlex e sul canale e seguire 
poi le istruzioni di sotto. 

Nell’APP toccando su [ ],  Setting è possibile attivare Message Notification per 
ricevere i push di movimento. 
Nell’NVR accedere in Sistema->Evento Normale e abilitare il canale (può essere 
anche in registrazione continua) su sui si desidera attivare il push. 
Nell’NVR accedere in Sistema->Avanzate->P2P e selezionare l’intervallo di 
Push(in minuti) tra un push ed il seguente. 
Gli stessi settaggi sono configurabili via APP (Device->Channel Setting). 

Nell’APP toccando su [ ],   Event Message è possibile visualizzare tutti i push 
ricevuti. 

 

ACCESSO DIRETTO (via APP)   
Questa modalità permette la visualizzazione dei flussi video dell’NVR con accesso diretto, senza l’utilizzo 
pertanto della configurazione assistita con codice QR. Nella tabella seguente sono confrontate le 2 diverse 
modalità di accesso. 

 Account(Login) Diretto 

QR Code Si No, WAN IP 

Accesso Tramite Server Tramite Server DDNS o IP diretto (se 
statico) 

Velocità di 
accesso 

Alta Molto Alta 
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Playback Si (continua, motion) Si (continua, motion) 

 

 Lanciare l’applicazione BitVision. 

 Toccare su [ ], toccare su + e toccare poi su IP/DDNS/SN, poi selezionare X/N/HVR. Nel campo 
Device Name digitare un nome che identifichi il dispositivo, in IP è necessario digitare il WAN IP (indirizzo 
pubblico o nome del DNS dinamico) della propria connessione e poi creare, nel router responsabile della 
connettività internet, dei Virtual Server (porta 554/6000 in TCP) verso l’indirizzo IP dell’NVR. In Private 
Port digitare 6000 (Configurazione->Rete->IP Porta e Porta privata) e poi le credenziali di accesso 
ed infine il numero di canali. Toccare poi su Save. 

 Per visualizzare il flusso video, accedere alla schermata principale di BitVision e selezionare RealTime, tenere 
premuto per qualche secondo sul rettangolo di un canale e spuntare il video da visualizzare (Local Device). 
Ripetere lo stesso processo per la visualizzazione di ulteriori canali. Toccare 2 volte sul canale per passare 
allo streaming unico (nello spazio dei canali) oppure evidenziare il flusso video (contorno giallo). 

       
 Una volta iniziata la riproduzione è possibile stopparla, catturare immagine/video tramite le apposite icone 

posizionate nella parte bassa. È possibile switchare al flusso HD/SD toccando l’apposita icona posta nella 
parte bassa. 

 

[Apple] Nel caso di accesso locale (con dispositivi Apple, 
aventi IP nella stessa rete dell’NVR) è opportuno 
accedere, sull’iPhone,  in Impostazioni, toccare 
sull’APP BitVision e spuntare la voce Rete Locale. 
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4.  Configurazione avanzata dell'NVR 

In questo capitolo verrà esaminato nel dettaglio la configurazione dell’apparato.  
Nello schema sotto riportato è visualizzato l’albero completo del MAIN Menu (si è supposto l'utilizzo della 
lingua Inglese per l’On Screen Display). Le voci non selezionabile non sono riportate. 

[ ]Preview: 
 

[ ]Playback: 
 

[ ]File Management: 
 

[ ]Smart Analysis: 
 

[ ]Channel: Camera Camera 

OSD 

Image 

PTZ 

Privacy Mask 

Channel Name 

Encode Parameters Main Stream 

Sub Stream 

[ ]Storage: 
Record 

Storage Device 

[ ]System: 
General  

Network TCP/IP (TCP/IP, DNS, PPPOE, NTP, 
FTP, UPNP) 

Address Filter 

Cloud Storage (Google, IPEYE) 

Advanced (Email, P2P) 

Setting User 

Event Normal Event 

Smart Event 

Live View Display 

View 

[ ]Maintenance:  
System Information Device 

Camera 

Record 

Alarm Record 

Network 

HDD 

Log 

Import/Export 

Upgrade Manual Upgrade 

Default 

Network 
Information 

Network Traffic 

Network Detection 

Auto Maintain 

HDD Operation SMART 

 

  [ ]Alarm: Permette la visualizzazione i vari allarmi (Exception, Normal Event, Smart Event).  

 [ ]Backup: Permette la visualizzazione dello stato dei backup in corso. 
 Power OFF:  Permette lo spegnimento(Shutdown), Reboot o Logout. 
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Talune Voci possono essere, a causa della lunghezza intrinseca e/o risoluzione di 
visualizzazione e/o carattere utilizzato, tagliate e/o incomplete. Ci scusiamo in anticipo 
per i disagi che questo potrà comportare. Si consiglia l’utilizzo della lingua inglese 
nell’OSD. 

 

 
4.1 MENU PRINCIPALE 
Per accedere al Menu Principale: 
 Mouse: cliccare il tasto destro del mouse, digitare la password e poi cliccare su Login[Accesso]. A 

questo punto cliccare sul tasto destro per visualizzare nella parte superiore le icone del menu principale. 
Per entrare nei sottomenu, muovere il mouse sull’icona corrispondente e premere il tasto sinistro.  

 

Le credenziali di accesso al dispositivo sono le seguenti: 
 user=admin 
 password=atlantis 

Molte funzioni sono disponibili solo con telecamere Atlantis (da 2MP/3MP e 5MP) della 
famiglia UltraPlex (A11-UX). Il protocollo ONVIF permette un controllo parziale delle IP 
Camera collegate. 
Ad esempio talune funzionalità [Privacy Mask] non sono sempre utilizzabili tramite il 
protocollo Onvif. 

Per disabilitare il Logout automatico selezionare NEVER alla voce Auto Log OUT  in 
System->General. 

 

4.2 PREVIEW 
Terminata la fase di boot l’NVR entra in modalità preview a schermo intero. 
Per entrare in questa modalità dal menu, cliccare su Preview e poi sull’icona Full Screen (ultima in basso a 
destra). 
Verrà visualizzata la modalità preimpostata. 
I flussi video verranno mostrati in Live (cliccare 2 volte il tasto sinistro su un canale per ottenere la 
visualizzazione a schermo intero, effettuando nuovamente un doppio click il dispositivo passerà alla modalità 
multicanale). 
Nella parte alto a destra verrà riportata, in overlay, la data e l’ora del dispositivo. 
Nella parte bassa, di ciascun flusso video, è presente una barra riportante le seguenti informazioni. 

[ ]: Registrazione Attiva. 

[ ]: Rilevazione movimento attiva (Motion Detection) 

 

Aggiunta Rapida di una Camera 
 Evidenziare un riquadro vuoto spostandoci sopra il mouse i cliccando il tasto sinistro. 

Il contorno diventerà di colore rosso, cliccare poi sull’icona [ ]. 
 Partirà la finestra di ricerca automatica, eventualmente cliccare su Search. Dopo 

qualche secondo verranno visualizzate le IP Camere rilevate. In Filter è possibile 
estendere la ricerca. 

In alternativa accedere al menu Channel e poi cliccare su Search nella parte bassa. 

Spostando il mouse nella parte inferiore dello schermo verrà visualizzata la barra di controllo. 
Sono presenti nell’ordine: 
 [Start] Spostando su questa icona è possibile visualizzare le opzioni di Shutdown, LogOut, System Setup 

e File Management. 
 [PlayBack] Permette di aprire la sezione Playback. 
 [Alarm] Permette di aprire la sezione Alarm. 
 [Record Status] Permette di aprire la sezione Record Status. 
 [Alarm Status] Permette di aprire la sezione Alarm Status. 
 [Disk Status] Permette di aprire la sezione Disk Status. 
 [Net Status] Permette di aprire la sezione Net Status. 
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 [System Info] Permette di aprire la sezione System Info. 
 [Poll] Permette l’abilitazione della modalità Poll. 
 [OSD] Permette di aprire l’abilitazione/blocco delle scritte OSD. 
 [Enable all day Record] Permette di aprire l’abilitazione della registrazione continua su tutti i canali. 
 [X/Y] Viene visualizzato il canale attivo, o nel caso di visualizzazione multicanale viene visualizzato il 

blocco di canali attivo nella preview. Cliccando sulle frecce è possibile spostarsi al blocco di canali contiguo. 
 Permette la visualizzazione del numero di canali selezionati (1,4,9+1,9,16). 
 Permette il passaggio/uscita alla/dalla modalità Full Screen. 
Cliccare due volte, il tasto sinistro, su un singolo canale per visualizzarlo a schermo intero. Premere 
nuovamente due volte il tasto sinistro per uscire dalla modalità full screen. 
Quando il singolo canale è in modalità Full Screen, cliccare il tasto sinistro per visualizzare nella parte bassa 
la barra (visualizzabile anche in modalità multicanale selezionando un canale col tasto sinitro): 

   
Le icone permettono nell’ordine di: 
 [Capture] Catturare in un’immagine quanto ripreso a video. Questi file sono visualizzabili in File 

Management. 
 [Instant Playback] Permette di riprodurre istantaneamente quanto registrato (la funzione registrazione 

deve essere attiva sul canale) negli ultimi 5 minuti. 
 [PTZ] Permette di aprire la sezione di controllo della PTZ. 
 [ZOOM] Permette di aprire la sezione di controllo dello ZOOM. È possibile selezionare il livello di zoom e 

spostare la finestra della parte di schermo che si desidera ingrandire. 
 [Audio] Funzionalità non supportata. 
 [IMAGE] Permette di accedere alla sezione di controllo dell’immagine della camera. 
 [Information] Permette di visualizzare informazioni circa lo streaming (fps, kbps, risoluzione, codec). 
 [Enable all day record] Permette di abilitare/disabilitare la registrazione 24 ore del canale. 
 [Switch to Main/Sub] Permette di cambiare il flusso visualizzato tra MAIN/SUB. 
 [FishEye] Funzionalità non supportata. 
 

 
4.3 PLAYBACK 
In questa sezione è possibile avere accesso a tutti i file video registrati nell'hard disk dell'NVR ed 
eventualmente farne una copia su una memoria USB collegata. 
L'NVR può, mentre registra ad una stabilita risoluzione, riprodurre un massimo di 4 canali. 
Selezionare, spuntandolo, nella parte alta a sx (sez 1) i canali da riprodurre, nella parte in basso a sx (sez 2) 
la data (mese, anno giorno). 
Il sistema visualizzerà un puntino VERDE nelle date dove sono presenti delle registrazioni (sez 2).  
Spuntare (sez 5), in basso, la tipologia di eventi di cui si desidera visualizzare le registrazioni. 

È possibile spuntare le voci [ ] con cui filtrare 
le registrazioni (Arancione=Tutte, Verdi=Normale, Gialla=Motion, Rossa=Allarme, Azzurro=Motion con 
Allarme, Blu=Non supportata) e scegliere poi la durata oraria (30 min, 1 ora, 2 ore, 6 ore, 24 ore). 
Nella barra oraria (sez 4) verrà visualizzata la presenza della registrazione (il colore riportato in legenda indica 
la tipologia di evento).  
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Un doppio click sulla barra porta all'avvio della riproduzione video. Cliccare sulle icone 24H, 6H, 2H, 1H o 30M 
per cambiare la granularità temporale migliore (sez 5). Durante la riproduzione un doppio click, sul tasto 
sinistro, nella finestra ne permette la visualizzazione a schermo intero.  
Sono disponibili funzioni per il fermo immagine (Pausa), avanzamento veloce ([Riproduzione veloce], sino 
a 16X), riproduzione al contrario ([Riavvolgimento]) (sez 3). 
Durante la riproduzione è possibile aggiungere dei TAG (spostare il puntatore sul video riprodotto, premere il 
tasto sx per visualizzare la barra di controllo e cliccare su Add TAG (sez 6) per aggiungere un TAG con una 
descrizione ad un determinato orario). Questi tag verranno visualizzati se il bottone TAG (sez 5) è attivo. 

 

Il throughput in scrittura può arrivare a 40/50Mbps, dipende dalle condizioni operative 
dell'NVR.  

Il sistema supporta solo FAT32 nelle periferiche USB connesse ed HDD.  
È necessario procedere alla formattazione preventiva del dispositivo. 
Taluni apparati possono risultare incompatibili col dispositivo. 

Il Backup può anche essere fatto, via LAN, usando il browser IE ed accedendo alla sezione 
Playback. 

L'NVR può spezzare file video eccessivamente lunghi in file più piccoli (circa 1GB di 
occupazione). File derivanti da rilevazione movimento (motion detection) sono 
solitamente più piccoli. 

VLC è in grado, scaricando i codec, di riprodurre i file di cui si è effettuato il backup. 
I file hanno una struttura riportante la data/ora iniziale. 

Esportare una Clip Video 
Durante il Playback, cliccare sull’icona CLIP (sez 3), agendo sul tasto sinistro spostare 
l’inizio e fine clip. Cliccare poi su Export Clip. L’NVR effettuerà la copia su USB. 

 
Cliccare su Clip Time per digitare invece direttamente l’orario di inizio e fine clip. 
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4.4 FILE MANAGEMENT 
In questa sezione è possibile avere accesso a tutti i file Video/Immagini registrati nell'hard disk dell'NVR 
ed eventualmente farne una copia su una memoria USB collegata. 
Analogamente alla sezione precedente è possibile scegliere il: 
 In Time selezionare l’intervallo temporale. 
 In Channel selezionare il canale video. 
 In File Type [Tipo di File] selezionare il tipo di file da ricercare tra Video, Picture. 
 In Tag è possibile filtrare scrivendo il nome del tag assegnato ad uno specifico evento. 
 In Event Type [Tipo Evento] selezionare il tipo di evento. 
Cliccare su Search[Ricerca] per effettuare la ricerca nel rispetto dei filtri impostati. 
L’NVR visualizzerà un elenco di file.  
Cliccando sul singolo file è possibile visualizzare l’immagine o far partire la riproduzione video. 
Spuntare i file e cliccare su Export[Esporta] per effettuarne la copia su USB. Spuntare su ALL[Tutti] per 
selezionare tutti i file visualizzati dalla ricerca effettuata. 

È possibile cambiare il tipo di visualizzazione dei file cliccando sulle icone [ ] o [ ] situate in alto a 
destra. 
 

4.5 SMART ANALYSIS 
Questa funzionalità richiede camere IP capace di supportare l’analisi intelligente. 
Consultare il manuale della camera IP. 
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4.6 CHANNEL 

4.6.1 Camera 
In questa sezione è possibile gestire la configurazione delle camere connesse ed aggiungerne di nuove. 
Per aggiungere una camera IP effettuare la seguente verifica. 

 
 Spostare la IP Camera sulla rete dell’NVR. 
 

 

È opportuno considerare che alcune camere IP in standard ONVIF potrebbero 
non essere supportate. 

È possibile anche aggiungere una telecamera ONVIF che non risulta 
configurabile/compatibile in modalità RTSP. Introdurre adesso in Main/Sub le path RTSP 
(vanno richieste al fornitore della IP Camera). 
In RTSP sostanzialmente si ha accesso al solo flusso video e tutte le altre funzionalità 
non sono supportate (movimento se PTZ, rilevazione movimento, maschera etc). 

 
 
AGGIUNGERE UNA CAMERA IP 
Per aggiungere Camere in un momento successivo, cliccare su 

 Aggiunta Manuale [Manual Add]: È possibile forzare una IP camera (anche nei primi 8 canali, 
riservati alle 8 camere PoE direttamente connesse). 

 Ricerca[Search] (nella parte bassa): La scansione viene effettuata nella stessa classe cui 
appartiene l’indirizzo IP dell’NVR, per effettuare una scansione multi classe selezionare nella combo 
box Filtra(Filter) la voce Rete Multisegmento (Multi Net Segment) e cliccare nuovamente su 
Ricerca (Search). Evidenziare la camera e cliccare su Aggiungi[Add]. Alcune IP Camere Onvif 
potrebbero incontrare problemi di compatibilità (il Link potrebbe essere di colore rosso). In caso di 
problemi questi potrebbero essere risolti cliccando rispettivamente sulle icone Cambia(Edit) della 
IP Camera in questione (password di accesso/lo streaming usato e la porta Onvif).  

In [ ]Canale[Channel]->Manin Stream/Sub Stream è possibile cambiare, tra le altre cose, la 
risoluzione dei flussi (main, substream), il bitrate(Kb/s) e il Frame Rate.  
In caso di ulteriori problemi prendere in considerazione IP Camere Ultraplex o IP Facile di Atlantis. 
 
MODIFICARE LA CONFIGURAZIONE DI UNA CAMERA IP 
 In Channel->Camera, passare alla modalità elenco (icona in alto a destra), cliccare su Edit, a fianco 

della camera IP di cui si desidera modificare le impostazioni e verificare le credenziali di accesso/Indirizzo 
IP/Porta. 

Se il risultato è comunque negativo provare ad importare il flusso video usando il protocollo RTSP. 
In Channel->Camera, passare alla modalità elenco (icona in alto a destra), cliccare su Add. Manually. 
Scegliere Protocol=RTSP, digitare username/password e le 2 path di accesso (da chiedere necessariamente 
al produttore della IP Camera).  Provare queste 2 path di accesso tramite VLC (media->Apri Flusso di rete) 
per verificarne la correttezza. 
 
4.6.2 PoE 
Questo menu non è selezionabile in quanto il dispositivo non integra lo switch PoE. Si raccomanda caldamente 
di alimentare le IP Camera tramite l’utilizzo di uno swith PoE Esterno. 

 

Le IP Camera Atlantis, a seconda del modello, possono essere alimentate nelle seguenti 
modalità: 
  [IP Camera con PoE] Direttamente tramite il cavo di rete se connesse ad uno switch 

PoE. Si raccomanda l’utilizzo di uno Switch PoE mode A/B. Atlantis consiglia i modelli 
A02-F5PoE4-A, A02-F9PoE8-A e A02-F18PoE16-A. 

 [IP Camera] Tramite jack, connesse ad un alimentatore (12V@1A). Si raccomanda il 
codice A02-Adapter1. 

 [IP Camera] Tramite A02-Splitter1 connesso ad uno switch/NVR PoE.  
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4.6.3 OSD 
Selezionare nella combo BOX Channel[Canale] il canale di cui si desidera impostare l’OSD. 
In Channel Name [Nome del Canale] è possibile digitare un identificativo ulteriore. 
Spuntare la voce Time[ORA] per visualizzare la stringa con informazioni su data ed ora (Date Format 
[Formato Data] è una combo box in cui è possibile sceglierne il formato). 
Spuntare la voce Text[Testo] per visualizzare quanto digitato in Channel Name [Nome del Canale]. 
In OSD Position [Posizione OSD] è selezionabile, tramite una combo box, la scelta del posizionamento 
(tra alto/basso a sinistra) di queste stringhe. 
Cliccando su Apply[Applica] si confermano i cambiamenti.  

 

Questa funzionalità può non essere supportata dalla camera Onvif.  
Questo Overlay viene impresso sul SOLO video registrato. 

 
4.6.4 Image 
In questa sezione è possibile impostare i parametri relativi all’immagine della IP Camera. A seconda della 
camera IP vengono visualizzati più o meno parametri a video. 
Solitamente sono controllabili regolazione del colore, contrasto. 
Talune camere offrono configurazioni avanzate. Si riportano sotto i parametri visualizzati dai modelli A11-
UX914XX. 
 Image Adjustement: In questa sezione   è possibile cambiare i livelli di 

Brightness(luminosità)/Contrast(contrasto)/Saturation(saturazione) e Sharpness(dettaglio). Al solito 
cliccare su Default per caricare i settaggi di fabbrica. 

 Exposure Settings: In questa sezione è possibile impostare i parametri circa l’esposizione. La scelta 
AUTO prevede un adattamento automatico, la scelta Manual è da preferirsi in caso di ambiente con 
luminosità controllata, sostanzialmente costante. È possibile inoltre impostare il guadagno su 256 livelli. 

 Backlight Settings: In questa sezione è possibile impostare i parametri per l'attivazione o meno delle 
funzioni della controluce. È possibile scegliere il livello tra i 3 proposti. Si consideri che viene effettuata 
un’analisi sull’intera scena e non parti di essa. 

 Day and Night Switch: In questa sezione è possibile controllare il tempo del ritardo, da 2s a 10s, di 
attivazione/disattivazione del filtro IRCut (non degli infrarossi). È inoltre possibile scegliere la modalità di 
attivazione nel menu Full Light Mode: attivazione oraria (Time), sempre attivo (Night), basato sull’analisi 
del video (DayTime), basato sul sensore luminoso posto in prossimità della lente (Automatic). È bene 
considerare che il filtro ICR è una lente che si frappone al sensore CMOS filtrando le componenti cromatiche 
dell’infrarosso che creerebbero delle aberrazioni cromatiche durante le ore diurne. Durante l’uso notturno 
questo filtro viene rimosso e permette alla luce infrarossa di colpire il CMOS e permettere la visione in 
bianco e nera notturna. Non ha nulla a che fare con l’attivazione/disattivazione degli infrarossi. La voce 
Light Brighness impatta sulla percentuale di attivazione degli IR (in caso di riflessi è possibile diminuire la 
luce infrarossa limitandone i riflessi). 

 White Balance: In questa sezione è possibile controllare il bilanciamento del bianco. Un’attenta 
regolazione permette una resa cromatica più fedele ma richiede una fase di analisi attenta al variare 
dell’intensità e sorgente luminosa della scena. 

 Video Adjustement: In questa sezione è possibile attivare filtri per la riduzione del rumore video. Questa 
funzione permette di diminuire il rumore tipico delle riprese con luminosità molto bassa in scene 
statiche/dinamiche (in scene dinamiche è presente un effetto scia). Questo parametro supporta diversi 
livelli. Il filtro 2DNR compensa scene prevalentemente statiche mentre il 3DNR si adatta a scene dinamiche. 

 Image Enhancement: In questa sezione è possibile impostare il flicker (indoor PAL/NTSC e Outdoor) o 
attivare la funzionalità WDR. La funzionalità WDR permette di ottenere buone immagini anche in presenza 
di condizioni di controluce (retroilluminazione) dinamico. In pratica l’esposizione (otturazione) viene 
cambiata e mediata a seconda di quanto ripreso nella scena (alta velocità per zone fortemente illuminate 
e bassa per zone scure). Questo rende l’immagine risultante più chiara ed omogenea con oggetti ben 
visibili. Questo risultato è ottenuto tramite effetti di post processing software effettuati dall’ISP.  Questa 
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funzionalità va attivata esclusivamente quando la camera è usata in outdoor, l’illuminazione indoor 
potrebbe generare effetti di flickering. 

 

In caso di flickering su video, controllare che Image->Image Enhancement abbia 
flicker control=PAL e Sensor Linear WDR=Shut Down se in ambienti indoor. 
Se il problema dovesse essere comunque essere presente rimuovere eventuali 
illuminazioni a neon, queste potrebbero generare una frequenza leggermente diversa dei 
50Hz e creare problemi di flickering. 

Si rimanda al manuale della IP Camera per maggiori dettagli. 

 
4.6.5 PTZ 
In questa sezione è possibile impostare i Preset e Cruise della PTZ. 
Si invita alla lettura del manuale della PTZ per avere ulteriori dettagli. 

 

Non è garantito che tutte le PTZ Onvif funzionino correttamente.  
In caso di problemi rivolgersi al produttore della PTZ, Atlantis non potrà offrire supporto 
alcuno per questo tipo di problematiche. 
In caso di problemi effettuare un aggiornamento FW della PTZ (contattando il 
produttore). 

 
4.6.6 Privacy Mask 
È possibile creare sino a 3 maschere di copertura. 
Selezionare, nella combo box Channel[Canale], il canale cui applicare la maschera. 
Muovere il mouse sul video raffigurato e premere, senza rilasciare il taso sinistro, sino a disegnare un 
rettangolo di copertura. Ripetere, sino a 3 volte, questa procedura. 
Il colore, richiamato a lato, permette, cliccando su Clear Zone1/2/3[Cancellare Zona1/2/3], di 
cancellare la maschera creata. 
Cliccare su Clear All [Cancellare Tutto] per rimuovere tutte le maschere create. 
Cliccando su Apply si confermano i cambiamenti. 

 

Molte funzionalità dell'NVR potrebbero non essere supportate (registrazione su Video 
Mask/Tampering) quando vengono utilizzati i protocolli ONVIF (in genere il motion 
funziona correttamente).  
 

 
4.6.7 Channel name 
È possibile assegnare ad ognuno dei 16 canale un nome. 
Cliccando su Apply si confermano i cambiamenti, mentre cliccando su Default il dispositivo, premio richiesta 
di conferma, userà i nomi preimpostati in fabbrica. 

 
4.6.8 Main Stream 
È possibile impostare per canale i settaggi del main stream della IP Camera. 

 

Per avere un'idea di quanto spazio i settaggi impostati occupino su disco all'ora/giorno, 
su registrazione continua, è opportuno considerare quanto segue: 
 CBR, 2Mbps sono 21GB al giorno e circa 900MB all’ora 
 VBR, 2Mbps sono al massimo 21GB al giorno e circa 900MB all’ora (dipende dal tipo 

di video ripreso) 
 CBR, 4Mbps sono 42GB al giorno e circa 1800MB all’ora 
 VBR, 4Mbps sono al massimo 42GB al giorno e circa 1800MB all’ora (dipende dal tipo 

di video ripreso) 

In questa sezione, per ogni canale, è possibile configurare i parametri Video inerenti la 
qualità/risoluzione/fps/BitRate del Sub Stream (accesso remoto e Live).   
 Channel[Canale]: Selezionare nella combo BOX il canale che si desidera configurare. 
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 Resolution[Risoluzione]: Selezionare la risoluzione video da utilizzare. A seconda della camera connessa 
questa combo-box può mostrare diverse risoluzioni disponibili. 

 [Stream Type]: Selezionare Video, o A/V nel caso in cui la Camera sia dotata anche di microfono per la 
cattura di rumori ambientali. Si ricorda che la cattura audio è considerata una tipologia di intercettazione 
ambientale ed è sempre, se si esclude l'ambito di uso privato, vietata dalla legge.  

 [BitRate]: Selezionare la modalità tra Variable e Constant. in Kbit/s il valore del bitrate da utilizzare.  
 [Frame Rate]: Scegliere il numero di frame al secondo da registrare.  
 [BitRate(Kb/s)]: Digitare in Kbit/s il valore del bitrate da utilizzare. Se si è scelto Constant questo valore 

è quello medio, se si è scelto Variable questo è quello massimo. 
 [Video Encoding]: Selezionare H264/H265. Questo codec è utilizzato per la conversione del video 

catturato. 
Cliccando Apply[Applica] si confermano i cambiamenti. 

 

4.6.9 Sub Stream 
È possibile impostare per canale i settaggi del sub stream della IP Camera. 
In questa sezione, per ogni canale, è possibile configurare i parametri Video inerenti la 
qualità/risoluzione/fps/BitRate del Sub Stream (accesso remoto e Live).   
 Channel[Canale]: Selezionare nella combo BOX il canale che si desidera configurare. 
 Resolution[Risoluzione]: Selezionare la risoluzione video da utilizzare. A seconda della camera connessa 

questa combo-box può mostrare diverse risoluzioni disponibili. 
 [Stream Type]: Selezionare Video, o A/V nel caso in cui la Camera sia dotata anche di microfono per la 

cattura di rumori ambientali. Si ricorda che la cattura audio è considerata una tipologia di intercettazione 
ambientale ed è sempre, se si esclude l'ambito di uso privato, vietata dalla legge.  

 [BitRate]: Selezionare la modalità tra Variable e Constant. in Kbit/s il valore del bitrate da utilizzare.  
 [Frame Rate]: Scegliere il numero di frame al secondo da registrare.  
 [BitRate(Kb/s)]: Digitare in Kbit/s il valore del bitrate da utilizzare. Se si è scelto Constant questo valora 

è quello medio, se si è scelto Variable questo è quello massimo. 
 [Video Encoding]: Selezionare H264/H265. Questo codec è utilizzato per la conversione del video 

catturato. 
Cliccando Apply[Applica] si confermano i cambiamenti. 

 

La visualizzazione remota è realizzabile quando la somma dei substream bitrate dei canali 
da visualizzare in contemporanea da remoto è inferiore (di circa il 30%) rispetto all’upload 
(reale, non quello dichiarato dal provider) del proprio accesso internet (ADSL/VDSL, 
Fibra, 3G, 4G, LTE). 
Ad esempio: Nel caso di ADSL (down=20Mbps, up=0,6Mbps) 4 canali con substream 
rate di 120Kbps l’uno, generano un upstream complessivo di 480Kbps e pertanto 
dovrebbero essere visualizzabili da remoto. 
 
È opportuno considerare anche che la velocità della linea (ADSL/VDSL, Fibra, 3G, 4G, 
LTE) dipende acnhe dall’altro traffico generato da altri apparati connessi o dalle condizioni 
di congestione del proprio operatore. 
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4.7 STORAGE 
In questa sezione è possibile conoscere lo stato di funzionamento dell’HDD e formattarlo e decidere, per 
canale, la modalità di registrazione. 

 
4.7.1 Record 
In questa sezione è possibile, per canale, selezionare le policy di registrazione. Il colore verde indica la 
registrazione orario programmata. È possibile impostare, a blocchi di un’ora, quando registrare il canale in 
oggetto. 
In Channel selezionare il canale video. Spuntare la voce Enable[Abilita] per attivare la registrazione. 
 Il colore giallo indica invece la registrazione su rilevazione del movimento.  
 Il colore rosso indica invece la registrazione su allarme (sensori in entrata).  
 Il colore azzurro indica invece la registrazione sia su rilevazione del movimento che allarme (sensori in 

entrata).  
Spuntare All[Tutti] per applicare i cambiamenti a tutti i giorni della settimana o spuntare i giorni che si 
desidera configurare. 
Cliccare su More Settings [Settaggi Avanzati] per impostare, in caso di motion, l’intervallo di registrazione 
in secondi antecedente l’evento e successivo all’evento. 

 

La presenza contemporanea dei colori giallo/verde indica una registrazione continua ma 
permette di attivare eventi (non la registrazione ovviamente) legati alla rilevazione del 
movimento. 

È possibile utilizzare sino ad un massimo di 6 differenti schedulazioni per canale. 

Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Copy[Copia] è possibile copiare la 
programmazione su un altro canale o tutti gli altri, cliccando Apply[Applica] si confermano i cambiamenti e 
si resta nella pagina. 

 

Rilevazione del movimento con camere UltraPlex. 

 [ ]Storage[Registrazione]->Record[Registra], selezionare il canale, 
spuntare enable[abilita] ed impostarlo su Motion [Ril Movimento] di colore 
giallo.  

 [ ]System[Sistema]->Normal Event [Evento Normale] ->Motion 
Detection [Ril Movimento] selezionare il canale e spuntare Enable[Abilita] e poi 
Set Area [Impostare Area] (solo l’area sotto la griglia rossa è analizzata per la 
valutazione del movimento) e la Sensitivity[Sensibilità]. Impostare poi l’intervallo 
di validità e impostare poi, in Linkage Action [Azione di Collegamento], la 
registrazione Channel Recording [Registrazione del canale]. 

Nella schermata di Preview verrà visualizzata l’icona [ ] ad ogni rilevazione di 
movimento. 
Opzionalmente è possibile attivare (linkage Action) anche l’allarme acustico, invio di 
una mail e l’uscita allarme (chiusura del contatto). 

 

4.7.2 Storage Device 
In questa sezione è possibile gestire le periferiche di memorizzazione interne connesse all'NVR, quindi gli HDD 
interni (Tipo Dispositivo=SATA). Eventuali periferiche connesse alla porta USB2.0 verranno visualizzate (Tipo 
Dispositivo=USB).   
 [No]: Indicativo numerico univoco. 
 Status[Stato]: Indica lo stato di funzionamento della periferica. In genere lo stato è Normal[Normale] 

o In Use [In Uso] ma in caso di problematiche lo stato passa ad Exception[Eccezione]. 
 Total Capacity[Capacità Totale]: Espresso in GB indica la capacità complessiva della periferica.  
 Residual Capacity[Capacità Residua]: Espresso in GB indica lo spazio libero nella periferica.  
 Device Type[Tipo Dispositivo]: Indica il tipo di dispositivo. USB=periferica connessa alla porta 

USB2.0. SATA=Disco rigido interno. 
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Cliccando su Refresh[Aggiorna] il dispositivo aggiornerà i dati sulle periferiche di memorizzazione, cliccando 
su Format[Formatta] (dopo aver preventivamente selezionato una periferica) il sistema provvederà ed 
effettuare la formattazione.  

 

Il sistema supporta solo FAT32 nelle periferiche USB connesse. 
È necessario procedere alla formattazione preventiva del dispositivo. 
Taluni apparati possono risultare incompatibili col dispositivo. 

Quando un nuovo HDD viene inserito nell'NVR, lo stato (HDD STATUS) è Not Formatted 
[Non Formattato]. L'NVR dovrebbe, salvo problemi, inizializzare il dispositivo. 
Al fine di utilizzare l’HDD è opportuno procedere alla formattazione (perdendo tutti i dati 
in esso contenuti) cliccando su Format[Formatta]. 
L’operazione di formattazione può richiedere diverso tempo a seconda delle capacità 
dell’HDD. Al termine del processo il dispositivo verrà riavviato. 

L’utilizzo di dispositivi in grado di catturare immagini, video o voce potrebbero essere 
regolamentati o completamente proibiti in talune giurisdizioni. Potrebbe essere richiesta 
un’autorizzazione. 
Atlantis non garantisce in alcun modo che i propri prodotti siano utilizzati in conformità 
con le leggi locali ed inoltre non può essere ritenuta responsabile per un uso improprio 
di tali dispositivi. 
È opportuno inoltre segnalare chiaramente la presenza di dispositivi capaci di catturare 
immagini, video o voce. 
Si ricorda infine di rispettare attentamente la legislazione vigente riguardante 
le modalità di conservazione dei contenuti video ripresi. A tal fine è opportuno, 
salvo nuove normative a cui si invita ad attenersi, utilizzare i seguenti 
settaggi: 
 System->General->Record Mode=Overwrite and Record Days=1 
 Sistema->Generale->Modalità Registrazione=Sovrascrittura e Data 

Registrazione=1 
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4.8 SYSTEM 
In questa sezione è possibile consultare lo stato di funzionamento del dispositivo. 

4.8.1 General 
In questa sezione è possibile selezionare le seguenti voci: 
 Language[Lingua]: Nella combo box è possibile selezionare l'idioma utilizzato nel menu. Il cambio 

dell'idioma necessita il riavvio del dispositivo. Gli idiomi supportati sono Inglese, Italiano (default). 
 Time Zone [Fuso Orario]: Nella combo box è possibile selezionare la zona oraria di appartenenza. 
 Record Mode[Modalità Registrazione]: Selezionare OverWrite[Sovrascrittura]. Questo permette al 

dispositivo di sovrascrivere i file più vecchi una volta che lo spazio sul disco è prossimo all’esaurimento. 
 Record Days[Giorni Conservati]: Il dispositivo permette di cancellare i file memorizzati superati i giorni 

indicati in questa combo box. Si invita il rispetto, in ambito non domestico/privato, della legislazione vigente. 
Fw successivi permetteranno di estendere la durata, al momento della stesura di questo manuale è 
consentita la sola registrazione di 1giorno nel pieno rispetto della legge vigente. 

 Auto Log Out[Tempo(min)LogOut]: Selezionare il tempo in minuti per il logout. Mettere il valore 
Never[Mai] per restare permanentemente loggati nel sistema. 

 Device name[Nome Dispositivo]: Digitare un identificativo alfanumerico, questo diverrà il nome del 
dispositivo. 

 Mouse Pointer Speed[Velocità Mouse]: Usare la barra per impostare la velocità del puntatore del 
mouse a schermo. 

 Se Enabled Wizard[Abilita configurazione Assistita all’avvio] è selezionata il dispositivo visualizzerà 
questa procedura ad ogni riavvio. 

 Date Format/Time Format/Separator: Permettono la configurazione della modalità grafica in cui la 
data ed ora sono visualizzate. 

 Enable DST: Permette di attivare l’ora legale. Impostare poi la data di inizio fine e l’OffSet (lasciare 60 
minuti). 

Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 

 

L’utilizzo di dispositivi in grado di catturare immagini, video o voce potrebbero essere 
regolamentati o completamente proibiti in talune giurisdizioni. Potrebbe essere richiesta 
un’autorizzazione. 
Atlantis non garantisce in alcun modo che i propri prodotti siano utilizzati in conformità 
con le leggi locali ed inoltre non può essere ritenuta responsabile per un uso improprio 
di tali dispositivi. 
È opportuno inoltre segnalare chiaramente la presenza di dispositivi capaci di catturare 
immagini, video o voce. 
Si ricorda infine di rispettare attentamente la legislazione vigente riguardante 
le modalità di conservazione dei contenuti video ripresi. A tal fine è opportuno, 
salvo nuove normative a cui si invita ad attenersi, utilizzare i seguenti 
settaggi: 
 Modalità Registrazione=Sovrascrittura e Giorni Conservati=1 

 
4.8.2 Network->TCP/IP-> TCP/IP 
 IP Address[Indirizzo IP]: 
 Enable DHCP[Abilita DHCP]: L’indirizzo IP verrà assegnato da un server DHCP disponibile in rete. È 

la modalità più semplice ma talune volte potrebbe genera problematiche nell’accesso remoto. 
Configurazione di default. Spuntare la voce Enable DHCP[Abilita DHCP] (la spunta è di colore rosso). 

 STATICO: È possibile utilizzare un indirizzo IP statico (con Subnet Mask, Default Gateway e DNS) 
assegnato manualmente in accordo con i parametri della rete. È opportuno verificare che la voce Enable 
DHCP]Abilita DHCP] non sia spuntata. Questa modalità è raccomandata quando si desidera effettuare 
un accesso remoto (sia WEB/CMS che da apparato Mobile) al dispositivo con accesso diretto.  

  Mac ADdress[MAC Dispositivo]: Viene visualizzato l’indirizzo MAC del dispositivo. 
 TCP port [Porta TCP]: Immettere la porta usata per l'accesso remoto. Il valore di default è 5000. 
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 HTTP Port [Porta HTTP]: Immettere la porta usata per l'accesso WEB. La porta usata di default è la 80. 
Nel caso si cambiasse tale porta (ad esempio 8082) per accedere al dispositivo utilizzare la sintassi seguente: 
http://IP:8082 

 RTSP Port[Porta RTSP]: Immettere la porta usata per l’accesso RTSP. Il valore di default è 554. 
 Private Port[Porta Privata]: Immettere la porta usata per l’accesso via APP diretto. Il valore di default 

è 6000. 
 Network Rate[Velocità rete]: Viene visualizzata la velocità della porta LAN. 

 

Per avere un accesso completo da remoto via WEB (esclusivamente tramite controlli 
Active X) è necessario girare il blocco di porte 80, 554 e 5000 in TCP.  

Cliccando su Refresh[Aggiorna] si attiva un refresh della pagina, cliccando su Default il dispositivo carica i 
valori di fabbrica, cliccando su Apply[Applica] si confermano i cambiamenti. 

 
4.8.3 Network->TCP/IP->DDNS 
Questo servizio è di grande aiuto per la visualizzazione remota (via CMS/Browser) oppure con App non basata 
su P2P (modalità Direct nell’applicazione Bit Vision). 
Sono disponibili anche altri client tra cui DynDNS, No-IP. 
 DDNS Type[Tipo DDNS]: Selezionare il fornitore di servizio (DynDNS, NO-IP). 
 Enable DDNS [Abilita DDNS]: Spuntare per abilitare il servizio di Dynamic DNS 
 Refresh Time[Intervallo Refresh (sec) : Selezionare l'intervallo di update in secondi dalla combo-box. 
 USERNAME[Nome Utente]: Inserire la username dell’account Dynamic DNS. 
 PASSWORD: Inserire la password dell’ account Dynamic DNS. 
 Domain[Dominio]: Inserire il nome di dominio. 
Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 

 
4.8.4 Network->TCP/IP->PPPoE 
Qualora si usasse un server PPPoE, immettere qua le credenziali di accesso. 
 

4.8.5 Network->TCP/IP->NTP 
In questa sezione è possibile configurare il server NTP. 
 Enable NTP[Abilita NTP]: Spuntare per attivare la richiesta oraria ad un server NTP. 
 [Server NTP]: Digitare l'indirizzo di un server NTP disponibile, oppure confermare il server 

(time.windows.com) preimpostato. Il server di default è time.windows.com. 
 [Custom]: Digitare un server NTP specifico. Questo è utilizzato solo se NTP Server=Custom. 
 NTP Port [Porta NTP]: È possibile cambiare la porta NTP utilizzata. La porta di default è 123. Non 

cambiare tale valore. 
 Interval(Min)[Intervallo(min)]: Selezionare, in minuti, l'intervallo di aggiornamento. 
Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 

 

Il cambio dell'ora non effettua la reimpostazione dei dati registrati in precedenza. 
Prestare attenzione a questo fatto durante la ricerca oraria di eventi. 

 
 
 
 

http://ip:8082/
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4.8.6 Network->TCP/IP->FTP 
È possibile utilizzare il protocollo FTP per effettuare l’upload, per canale, di immagini su rilevazione del 
movimento verso un server FTP in determinati giorni/intervalli temporali. 
Spuntare la voce Enable FTP[Abilita FTP] per attivare questa funzionalità. 
 FTP Server[Server FTP]: Immettere l'indirizzo IP del server FTP. 
 FTP Port[Porta FTP]: Immettere la porta utilizzata dal server per la connessione. Il valore di default è 21. 
 Username[Nome Utente]: Inserire la username dell’account per accesso al server FTP. 
 [PASSWORD]: Inserire la password dell’account per accesso al server FTP. 
 [File Upload]: Inserire la Path del percorso. Il carattere “.” Al pari di altri caratteri speciali non è supportato. 

Non sono supportate sottodirectory. 
 Channel[Canale]: Selezionare il canale nella combo box. 
 Week[Giorno Settimana]: Selezionare quando è attivo l’upload su FTP.  
 Time Period1/2[Schedulazione Oraria1/2]: Selezionare l’ora inizio/fine. È obbligatorio mettere almeno 

un intervallo (nel caso selezionare 00:00 sino 23:59). 
 Test: Cliccare per testare la funzione FTP. Un file di testo viene scritto nel server FTP. 

 

Il client FTP integrato nell’NVR potrebbe non funzionare con alcuni server 
FTP. Se il problema persistesse utilizzare un altro server FTP. 
Non sono supportati caratteri speciali quali “.”, “;”,”:” etc. 

Impostare i settaggi per ii singolo canale (canale, Giorno Settimana, almeno una 
schedulazione attivata con la spunta verde) e cliccare su Apply[Applica]. 
Ripetere la procedura per tutti i canali. 
NOTA: Impostati i settaggi di attivazione dell’upload FTP, al rientro questi non 
vengono mostrati (del campo giorno settimana non viene visualizzata l’impostazione 
salvata). 
NOTA: Il filtraggio avviene solo tramite la schedulazione ORARIA e non tiene conto 
della schedulazione giornaliera. 

L’evento responsabile dell’Upload è il Motion Detection che pertanto va 
attivato sul canale in questione. Si ricorda che camere Onvif possono non essere in 
grado di negoziare correttamente la rilevazione del movimento con l’NVR. 

Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 

 
4.8.7 Network->TCP/IP->UPNP 
Controllare che la voce Enable[Abilita] sia attiva (la spunta è di colore rosso) per abilitare il protocollo UPnP. 
Se il router supporta tale protocollo l'NVR automaticamente aprirà le porte necessarie al funzionamento. 
La voce Status[Stato] è su [Connecting/In Connessione e poi su Connected/Connesso] se il router 
ha il protocollo UPnP attivo.   
Cliccando su Add/Delete[Aggiungi/Rimuovi] è possibile creare/rimuovere una regola sul Router (via 
UPnP) per aprire determinate porte. A secondo del router utilizzato possono esserci dei problemi di 
interoperabilità (in questo caso accedere direttamente al router e creare i Virtual Server necessari). 
Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 

 
4.8.8 Network->Adress Filter 
È possibile utilizzare dei filtraggi su IP/MAC. Sono disponibili 2 tipologie White List permette esclusivamente 
l’accesso agli indirizzi contenuti, mentre Black List permette l’accesso a tutti gli indirizzi esclusi quelli 
espressamente contenuti. 

 

Possono essere immessi sino ad un massimo di 128 indirizzi. 
L’indirizzo MAC non è case sensitive, è composto da una serie di 2 caratteri separati dal 
“:”. 
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4.8.9 Network->Cloud Storage 
In questa sezione è possibile configurare le impostazioni per l’invio delle immagini (in caso di rilevazione del 
movimento) sul proprio spazio cloud (Google). Verrà creata una cartella, per giorno/ora, all’interno della 
cartella creata (Upload Folder) dove il dispositivo caricherà tutte le immagini associate alle rilevazioni del 
movimento. 
Questo servizio può essere configurato anche da BROWSER WEB (Configuration->System->Network-
>Cloud Storage). 

 
Google Drive 
Effettuare il LOGIN via browser verso il proprio account Google. 
Controllare che la voce [Enable] sia attiva per abilitare questo servizio. Spuntare la voce Google e cliccare 
su (Bind).  
Aprire la pagina, dopo aver effettuato il login in google, all’indirizzo https://www.google.com/device e 
copiare il codice (XXX-YYY] riportato a video. Continuare, in google, su web autorizzando il dispositivo (cliccare 
su Avanti e poi Consenti). Tornare sull’NVR e cliccare Conferma. 
A schermo dovrebbero essere visualizzati i dati dello spazio Google Drive e cliccando su Prova Connessione 
dovrebbe essere visualizzato un esito positivo. 
Ad ogni Motion Detection un’immagine in risoluzione substream viene caricata sullo spazio condiviso. 

 

Questo servizio è legato alle policy di Google. Qualora queste dovessero 
mutare il servizio potrebbe non funzionare. Atlantis non può essere 
ritenuta responsabile per questo. 

Il sistema effettuerà l’upload automatico su Motion Detection. 

 

 
4.8.10 Network->Advanced->Email 
In questa sezione è possibile configurare le impostazioni per l’invio della mail (sistematica in caso di rilevazione 
del movimento). Alla mail verrà allegato un file JPEG di quando è scattata la rilevazione del movimento ed 
una descrizione testuale dell'evento rilevato. 
Spuntare la voce Enable Mail [Abilita Notifiche via MAIL] per attivare questa funzionalità. 
 SMTP Server [Server SMTP]: Digitare il nome o l’indirizzo IP del server SMTP. 
 SMTP Port [Porta SMTP]: Selezionare la porta utilizzata dal server SMTP. Normalmente il valore è 465. 
 Username [Nome Utente]: Inserire la username dell’account per accesso al server SMTP. 
 [PASSWORD]: Inserire la password dell’account per accesso al server SMTP. 
 Sender [Mittente]: Digitare la Mail del mittente (usata anche come Login di accesso). 
 Recipient 1/2/3 [Destinatario 1/2/3]: Indirizzo mail cui inviare la segnalazione. 
 Subject [Oggetto]: Digitare l’oggetto della mail. 
 Message Interval [Intervallo di invio(min)]: Impostare in minuti l'intervallo minimo di invio mail (al 

fine di evitare l'invio di un elevato numero di mail dovute alla stessa rilevazione). 
 Encryption [Cifratura]: Spuntare per attivare la cifratura SSL. 
 Attach File [Allegato]: Spuntare per allegare alla mail un'immagine. 
 Time Period 1 / 2 [Schedulazione Oraria 1 / 2 ]: Selezionare l’ora inizio/fine. È obbligatorio mettere 

almeno un intervallo (nel caso selezionare 00:00 sino 23:59). Questa schedulazione è generale ed impatta 
sul servizio di inoltro mail. 

 Enable Auto Email: Permette l’invio di mail continuative. 
Cliccare su Email Test [Invio Mail di Prova] per verificare che la connessione verso il cloud sia corretta. 
Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 
 

 

Non è garantito che il client software integrato nell’NVR funzioni con tutti i 
server SMTP. Controllare attentamente le impostazioni. Se il problema 
persistesse utilizzare un altro server SMTP. 

Con Gmail utilizzare i seguenti settaggi: 
 SSL: attivo 

https://www.google.com/device
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 SMTP Server: smtp.gmail.com 
 SMTP Port: 465 
È opportuno attivare sul proprio account GMAIL la modalità APP MENO 
SICURE. 

Nella mail inviata, il cui allegato è una immagine in formato JPG del canale selezionato, 
ad inizio della rilevazione, sono contenute le seguenti informazioni: 
 Date: 
 Time: 
 Channel number: 

Gli eventi responsabili dell’invio mail sono il Motion Detection, Alarm IN, Video Loss,  
Errore HD o Problema su Rete che pertanto vanno opportunamente configurati. 

 
4.8.11 Network->Advanced->P2P 
Controllare che la voce Enable P2P[Abilita P2P] sia attiva (la spunta è di colore rosso). 
Utilizzando l’applicazione Bit Vision, disponibile su iOS e Play Store, è possibile accedere immediatamente 
all’apparato senza effettuare alcuna configurazione su altri apparati di rete.   
Digitare dopo aver creato un account (nell’APP Bit Vision) il numero univoco riportato sotto il primo codice 
QR o scansionare il codice QR stesso. 

 

Controllare che la voce Status[Stato] sia Online.  
In caso questa sia su Offline controllare: 
 Enable P2P[Abilita P2P] sia spuntato. 
 Controllare che la configurazione IP sia corretta. 

L’opzione PUSH interval permette di selezionare l’intervallo di PUSH. Questa 
funzionalità, non dichiarata, è in beta e non ne è pertanto garantito il 
corretto funzionamento. 

Cliccando su Refresh[Aggiorna] si attiva un refresh della pagina, cliccando su Apply[Applica] si 
confermano i cambiamenti ma si resta nella pagina. 

 
4.8.12 Setting->User 
In questa sezione è possibile modificare/creare utenti per l’accesso al dispositivo con profilazioni diverse. 

 

L’utente Admin non può essere modificato (solo la password può essere cambiata) né 
cancellato. 

Cliccare su Add[Aggiungi Utente] per creare un nuovo utente. Verrà richiesta la password di 
amministratore. 
Inserire nell’ordine Username[Nome Utente], Password (con conferma). Scegliere poi, in Level[Livello] 
il gruppo di appartenenza.  
In Authority è adesso possibile profilare, nel dettaglio, l’utente. 
In Modify[Modifica] è adesso possibile cambiare la password e livello. 
In Delete[Rimuovi] è possibile rimuovere l’utente creato. 

 
4.8.13 Event->Normal Event->Motion Detection 
In questa sezione va abilitato il canale su cui si è attivato, nella sezione [Storage]Registra la registrazione 
su Rilevazione del movimento (giallo).  
 Channel[Canale]: Selezionare nella combo BOX il canale di cui si desidera impostare le policy di rilevazione 

movimento. 
 Enable[Abilita Ril. Movimento]: Spuntare per abilitare la rilevazione del movimento sul canale 

selezionato. 
 Set Area [Impostazione Area]: È possibile selezionare le porzioni di schermo su cui effettuare l'analisi 

del movimento (22x18). Le celle selezionate (usate per controllare il movimento) sono contornate di rosso, 
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mentre quelle trasparenti vengono ignorate. Premendo il tasto sinistro e mantenendolo premuto mentre si 
muove il mouse è possibile disegnare un rettangolo la cui superficie sottesa verrà attivata/disattivata. Al 
solito premere il tasto sinistro sulla singola cella per attivarla/disattivarla.  Cliccare sul tasto destro per 
uscire. 

 Sensitivity[Sensibilità]: Scegliere il livello di sensibilità, tra quelli proposti nella combo box. 
 Arming Schedule[Schedulazione]: Selezionare l’intervallo in cui la rilevazione va attivata. 
 Linkage Action: Selezionare, alla rilevazione del movimento, cosa si desidera venga effettuato: 

 Buzzer Alarm [Allarme Acustico]: Emette una segnalazione acustica. Selezionare in Buzzer  (sec) 
la durata (sino a 120s) di tale segnalazione. 

 Email Notification [Invia mail]: Spuntare per inviare una mail. La mail verrà inviata al contatto 
inserito (sino a 3) e conterrà DATA/ORA, CANALE ed EVENTO (motion) ed una immagine in 
allegato(jpg). 

 Channel Recording [Registra Canale]: Se spuntato il sistema registra il video, sul disco interno, per 
un intervallo impostato in Storage->More Settings. 

 Alarm Output: Spuntare per attivare l’allarme di uscita. 
Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Copy[Copia] è possibile copiare la 
programmazione su un altro canale o tutti gli altri, cliccando su Apply[Applica] si confermano i cambiamenti. 

 

La registrazione su movimento è ATTIVA quando il canale è impostato esclusivamente, 
data la fascia oraria/giornaliera desiderata, col colore giallo [Storage]Registra. 
In More Settings è possibile impostare il tempo di Pre e Post recording. 

Quando attiva la rilevazione del movimento potrà essere sistematicamente connessa 
anche ai servizi di rete: 
 FTP 
 Cloud  Storage (google Drive) 
 Email 
Pertanto, se configurati, ad ogni evento di rilevazione del movimento i servizi di cui sopra, 
saranno attivi. 

Molte funzionalità dell'NVR potrebbero non essere supportate (registrazione 
su Video Mask/Tampering) quando vengono utilizzati i protocolli ONVIF (in 
genere il motion funziona correttamente).  

 
 
4.8.14 Event->Normal Event->Video Loss 
In questa sezione va abilitato il canale di cui si desidera controllare la disconnessione. In Linkage Action è 
possibile selezionare cosa si desidera venga effettuato: 

 Screen Display: Attiva la visualizzazione a schermo di una finestra con la notifica. 
 Email Notification [Invia mail]: Spuntare per inviare una mail. La mail verrà inviata al contatto 

inserito (sino a 3) e conterrà DATA/ORA, CANALE ed EVENTO (video loss). 
 Buzzer Alarm [Allarme Acustico]: Emette una segnalazione acustica continuativa. 
 Alarm Output: Spuntare per attivare l’allarme di uscita. 

Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Copy[Copia] è possibile copiare la 
programmazione su un altro canale o tutti gli altri, cliccando su Apply[Applica] si confermano i cambiamenti. 

 
4.8.15 Event->Normal Event->Alarm Input 
In questa sezione è possibile attivare uno dei 4 ingressi allarme disponibili. 
Selezionare, cliccandoci sopra col tasto sinistro, uno dei 4 ingressi disponibili. Cliccare su Edit per configurarlo 
secondo le proprie esigenze. 
In Alarm Input selezionare l’ingresso allarme che si desidera modificare. 
In Type selezionare la modalità di funzionamento.  
 NO: il contatto è normalmente aperto e viene allarmato quando diventa un corto circuito.  
 NC: il contatto è normalmente chiuso e viene allarmato quando diventa un circuito aperto. 
In Alarm Name digitare un nome che ne faciliti l’identificazione. 
Spuntare (in rosso) Enable per abilitare l’ingresso.  
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 In Linkage Action è possibile selezionare cosa si desidera venga effettuato: 

 Screen Display: Attiva la visualizzazione a schermo di una finestra con la notifica. 
 Email Notification [Invia mail]: Spuntare per inviare una mail. La mail verrà inviata al contatto 

inserito (sino a 3) e conterrà DATA/ORA, CANALE ed EVENTO (video loss). 
 Buzzer Alarm [Allarme Acustico]: Emette una segnalazione acustica continuativa che dura al 

massimo l’intervallo impostato in Delay Time(s) (in Normal->Buzzer). Se l’allarme in ingresso si 
interrompe, la segnalazione acustica è interrotta. 

 Channel Recording: Spuntare in verde il canale che si desidera attivi la registrazione in concomitanza 
dell’allarme in ingresso. Questo canale in Storage->Record deve avere la schedulazione su Alarm (in 
rosso). 

 Alarm Output: Spuntare per attivare l’allarme di uscita. 
In Arming Schedule è possibile selezionare l’intervallo temporale di attivazione (senza questo l’ingresso 
viene ignorato). 
Cliccando su Copy[Copia] è possibile copiare la programmazione su un altro canale o tutti gli altri, cliccando 
su Apply[Applica] si confermano i cambiamenti. 

 

Si invita alla lettura dell’appendice B prima di effettuare il cablaggio del dispositivo. Un 
cattivo cablaggio può portare alla rottura del dispositivo invalidandone la garanzia. 

 
4.8.16 Event->Normal Event-> Alarm Output 
In questa sezione è possibile configurare le 4 uscite. 
Selezionare, cliccandoci sopra col tasto sinistro, e cliccare poi su Edit per configurarlo secondo le proprie 
esigenze. 
In Alarm Output viene mostrato l’output che si desidera modificare. Il modello in questione supporta 4 
uscite. 
In Delay è possibile scegliere il tempo, in secondi, per cui l’uscita continuerà ad essere allarmata sino 
all’interruzione dell’evento scatenante. 
In Alarm Name digitare un nome che ne faciliti l’identificazione. 
In Alarm Status viene mostrato lo stato attuale.  
In Arming Schedule è possibile selezionare l’intervallo temporale di attivazione (senza questo l’uscita 
viene ignorata). 
Cliccando su Copy[Copia] è possibile copiare la programmazione su un altro canale o tutti gli altri, cliccando 
su Apply[Applica] si confermano i cambiamenti. 
Cliccando su Trigger si può provare ad attivare l’uscita per verificare che il circuito connesso (Sirena) funzioni 
correttamente. Quando allarmato Alarm Status si sposterà su Enable. 

 

Si invita alla lettura dell’appendice B prima di effettuare il cablaggio del dispositivo. Un 
cattivo cablaggio può portare alla rottura del dispositivo invalidandone la garanzia. 

 

4.8.17 Event->Normal Event-> Exception 
In questa sezione è possibile programmare le azioni del sistema all'evento errore su HDD e problematica di 
rete. 
 Selezionare in Event Type[Tipo Evento] il tipo di evento tra No Disk, Disk Error, Broken Network 

e IP Conflict. 
 Enable[Abilita]: Spuntare per abilitare la rilevazione dell’errore selezionato. 
In Linkage Action è possibile selezionare cosa si desidera venga effettuato: 

 Screen Display: Attiva la visualizzazione a schermo di una finestra con la notifica. 
 Email Notification [Invia mail]: Spuntare per inviare una mail. La mail verrà inviata al contatto 

inserito (sino a 3) e conterrà DATA/ORA e tipo di EVENTO. 
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 Buzzer Alarm [Allarme Acustico]: Emette una segnalazione acustica continuativa. 
 Alarm Output: Spuntare per attivare l’allarme di uscita. 

Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 

 
4.8.18 Event->Normal Event-> Buzzer 
In questa sezione è possibile impostare, in Delay Time(s) la durata in secondi (tra 1s e 120s) della 
segnalazione acustica. Superato tale intervallo la segnalazione acustica verrà interrotta. 

 
4.8.19 Event->Smart Event 
Questa funzionalità viene supportata solo sulle camere UltraPlex dotate di funzionalità AI. 

 
4.8.20 Live View->Display 
In questa sezione è possibile selezionare, in Resolution[Risoluzione] la risoluzione d’uscita della porta 
HDMI/VGA (limitata al Full HD). Le 2 uscite sono duplicate e non indipendenti. 
In UI Trasparency è possibile impostare, usando lo slider, la trasparenza dell’OSD. Il puntatore sulla parte 
blu a sinistra garantisce un elevato contrasto, mentre se posizionato nella parte rossa a destra offre un 
contrasto più morbido. 
Spuntare la voce Show OSD Time per visualizzare, in alto a sinistra, l’ora e data rilevate dall’NVR. 
La combo box in Show after Boot permette invece di selezionare la modalità (di canali) utilizzata al riavvio. 
Cliccando su Default il dispositivo carica i valori di fabbrica, cliccando su Apply[Applica] si confermano i 
cambiamenti. 
 
 

4.8.21 Live View->View 
In questa sezione è possibile configurare la schermata di preview/output. Tale funzionalità è supportata in 
appositi apparati. 
Questo dispositivo duplica su entrambe le uscite (HDMI/VGA) lo stesso output.   
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4.9 MAINTENANCE 
In questa sezione è possibile consultare lo stato di funzionamento del dispositivo. 

 

4.9.1 Device 
In questa sezione è possibile conoscere maggiori informazioni circa il dispositivo ed il FW installato. 

 
4.9.2 Camera 
In questa sezione è possibile conoscere maggiori informazioni circa lo stato delle IP Camera. Viene 
visualizzato, per canale, il nome (Channel Name), lo stato (Status), il Motion Detection (se attivo o 
meno) e Video Loss (se attivo o meno). 

 
4.9.3 Record 
In questa sezione è possibile conoscere maggiori informazioni circa lo stato dei canali, se attivi, il BitRate e 
la modalità di registrazione. 

 
4.9.4 Alarm Record 
In questa sezione è possibile conoscere maggiori informazioni circa lo stato dei canali, se sono in modalità 
N.O o N.C e se sono allarmati o meno. 

 
4.9.5 Network 
In questa sezione è possibile conoscere maggiori informazioni circa l’interfaccia WAN del dispositivo. Sono 
visualizzate informazioni circa l’indirizzo IP, Gateway, Subnet Mask, DNS e MAC address oltre alla modalità 
di assegnazione dell’indirizzo IP (DHCP o Fixed). 

 
4.9.6 HDD 
In questa sezione è possibile conoscere maggiori informazioni circa l’HDD, lo spazio libero ed occupato. 

 
4.9.7 LOG 
In questa sezione è possibile avere accesso ai Log di sistema. Selezionare in Type[Tipo] la tipologia di LOG 
da cercare e perfezionare la scelta limitandone l’intervallo temporale Start Time/End Time[Inizio/Fine]. 
L’ intervallo temporale ha una durata massima di 7 giorni. Cliccare infine su Query[Interroga].   
La singola tupla contiene informazioni circa: Informazioni data e orarie (Time[Ora]), Dettagli sul tipo di Log 
(Event[Evento]) ed Utente (User[Utente]). 
Cliccare le frecce per spostarsi tra le pagine dei LOG, Clear[Svuota] per svuotare la memoria dei Log, 
Export[Esporta] per esportare su USB i file log. 
 
4.9.8 Import/Export 
In questa sezione è possibile importare o esportare il file con la configurazione dell’NVR. 
Il dispositivo produrrà sulla periferica USB un file cifrato con estensione .INI con la configurazione del 
dispositivo. 

 
4.9.9 Manual Upgrade 
In questa sezione è possibile caricare una nuova release di firmware. Consultare il sito www.atlantis-land.com. 
Per effettuare un upgrade, seguire la procedura riportata. 
Al momento di andare in stampa le versioni di FW è V20.1.35.1_E00020347. 
Inserire la chiavetta formattata in FAT 32 dove si è preventivamente copiato il FW (scaricabile sul sito alla 
pagina di prodotto). Spegnere l'NVR. Riavviare l'NVR e selezionare il FW e cliccare su Upgrade[Aggiorna], 
nella schermata seguente cliccare su Confirm[Conferma]. 
La barra mostrerà lo stato di avanzamento, questa fase è estremamente lenta (diversi minuti). Al termine del 
processo spegnere l'NVR e rimuovere la periferica USB contenente il FW. Riavviare l'NVR.  
Terminata la procedura provvedere ad effettuare il reset del dispositivo (4.9.10). 
Sul sito potrebbero essere disponibili aggiornamenti. 
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Per l'upgrade del dispositivo procedere nella seguente modalità. 
 Inserire una periferica di memorizzazione USB, formattata in FAT32, con nella root il 

nuovo FW. 
Durante la fase di upgrading è opportuno non rimuovere la chiavetta USB e 
garantire l'alimentazione elettrica all'apparato. 
Prima di iniziare rimuovere tutti i cavi di rete e resettare il dispositivo alle 
condizioni iniziali. 

Il sistema supporta solo FAT32 nelle periferiche USB connesse ed HDD.  
È necessario procedere alla formattazione preventiva del dispositivo. 
Taluni apparati possono risultare incompatibili col dispositivo. 

FW non espressamente progettati per il modello su cui sono installati possono 
rendere inutilizzabile l’apparato invalidandone la garanzia. Prestare la 
massima attenzione prima di effettuare l’aggiornamento del FW. 

 
4.9.10 Default 
In questa sezione è possibile effettuare un ripristino delle condizioni iniziali. È possibile effettuare il reset di 
un intero gruppo, una singola sezione o dell’intero dispositivo Restore Factory Reset [Reset alle 
condizioni iniziali]. 
Cliccando su Apply[Applica] si confermano i cambiamenti. 

 
4.9.11 Network Traffic 
In questa sezione è possibile visualizzare, per canale, il Bitrate (KB/s), la risoluzione e l’andamento nel tempo 
del bitrate. Nella parte superiore è invece visualizzato il bitrate complessivo dell’intero NVR sia in ricezione 
(dalle varie IP Camera) che invio (verso la WAN).  

 
4.9.12 Network Detection 
In questa sezione è possibile effettuare un PING verso un indirizzo IP da inserire. Cliccare sul bottone TEST 
per effettuare la verifica. 

  
4.9.13 Auto Maintain 
La modalità Autoreboot permette il riavvio programmato dell'NVR su base quotidiana e/o settimanale o 
mensile.  
Cliccando su Default il dispositivo carica i valori di fabbrica (riavvio programmato alle 3:03 AM ogni 
mercoledì), cliccando su Apply[Applica] si confermano i cambiamenti. 

 

Le principali cause di blocchi andrebbero ricercate in una cattiva tensione di 
alimentazione e/o anomale condizioni di funzionamento (temperatura elevata). Si 
consiglia di proteggere il sistema NVR e le IP Camera (alimentate da uno swith PoE) 
dietro ad un gruppo di continuità dotato almeno di funzionalità AVR (A03-
HP1002/1502/2002/3002). 

 
4.9.14 Smart 
In questa sezione è possibile visualizzare lo stato del test SMART dell’HDD. Questa funzionalità può essere 
testata solo su determinati HDD. Quando l’HDD supporta tale modalità di test è presente un bottone 
Self Test. Cliccare per far partire lo smart test (la durata può variare).  

 

Durante il test il disco potrebbe non registrare correttamente i flussi video. 
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5.  Funzionalità di Rete  

Ci sono differenti metodologie per accedere remotamente/localmente all'NVR attraverso le funzionalità di rete: 
 Utilizzare il browser Internet Explorer (con Active X per configurazione e Live View) o 

Chrome/Edge/Firefox (solo configurazione). 
 Utilizzare per iPhone/iPad/Android l'applicazione BitVision. 
 Utilizzare il software CMS per ambienti Windows 7/8/10 (scaricabile dal sito WEB alla pagine di 

prodotto, nella sezione download). 
Lo schema concettuale di accesso remoto dovrebbe essere il seguente. Tutti i dispositivi ovviamente possono 
effettuare un accesso locale se appartengono alla stessa LAN. 
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5.1 Accesso tramite Browser 
È possibile utilizzare Internet Explorer (IE) 6.0 o versione più recente per accedere localmente o remotamente 
all'NVR. Solo con IE è possibile visualizzare i flussi video. 
Altri browser permettono la configurazione ma non la visualizzazione di flussi video. 
 

 

Qualora non si riuscisse ad installare il controllo active X (IE non potrà mostrare il video 
del NVR), verificare quanto segue: 
 In Strumenti->Opzioni Internet->Protezioni selezionare Internet/Intranet 

ed impostare il livello Medio Alto Predefinito. 
 In Strumenti->Blocco Popup   selezionare Disattiva Blocco Popup. 

 
 

 

 

Visualizzazione LIVE con Windows 10 in EDGE 
Edge non supporta ActiveX quindi non è in grado di visualizzare direttamente i flussi video 
dell’NVR.  È possibile però, seguendo le istruzioni seguenti, utilizzare la modalità IE 
integrata in Edge. 
 Cliccare su Altre Azioni (…) e selezionare Apri con Internet Explorer. 
 Digitare a questo punto l’indirizzo IP del dispositivo per accedere come di consueto. 

 

Per effettuare un accesso locale operare nella seguente modalità: 
 In System->Network->TCP/IP è possibile conoscere l’IP assegnato all'NVR (nel campo IP address). 
 Accedere col browser web all’indirizzo di sopra e premere il tasto invio (in figura si è assunto che l’indirizzo 

IP fosse 192.168.3.103) 

 
 Al primo accesso potrebbe rendersi necessario installare alcuni componenti Active X (in IE).  
 La password di default è la stessa dell'accesso tramite mouse (admin, atlantis) e cliccare su Login. 

 
Per effettuare un accesso remoto operare nella seguente modalità: 
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 L'NVR deve essere collegato, via LAN ad un dispositivo capace di offrire connettività verso internet 
(normalmente un router ADSL/VDSL/Fibra o altra tecnologia). 

 La password di accesso di default è la stessa usata per l'accesso tramite mouse (admin, atlantis). 
 In System->Network->TCP/IP è possibile conoscere l’IP assegnato all'NVR (nel campo IP 

Address/Indirizzo IP).  È opportuno assegnare un indirizzo IP statico compatibile con la propria rete LAN. 
 In TCP/HTTP/RTSP Port modificare secondo le proprie esigenze ed annotare tali valori. I valori di 

default sono 5000, 80 e 554. 
 Accedere al Router (IP LAN) responsabile della connettività e creare 3 Virtual Server TCP sull’IP statico 

assegnato all'NVR per i 3 numeri di porte di sopra. 
 Accedere col browser all’indirizzo pubblico del router*(se si è cambiato HTTP Port con un numero di 

porta diverso da 80 digitare quanto segue: http://IP WAN Router: HTTP Port) e premere il tasto 
invio. Alla prima installazione potrebbe rendersi necessario installare alcuni componenti Active X (su IE) 
Si ricorda che Il dispositivo, permette la visualizzazione di flussi video esclusivamente tramite active X. 

In Windows 10 (Edge) utilizzare la modalità Apri con Internet Explorer, dal menù impostazioni [ ]. 
 

 

Qualora il contratto con l’ISP non preveda un IP statico è possibile utilizzare un servizio 
Dynamic DNS.  

La password di accesso di default è la stessa usata per l'accesso tramite mouse (admin, 
atlantis). 

Talune combinazioni di Browser/Plugin installati possono impedire la visualizzazione via 
web. I questo cosa si raccomando l'utilizzo del CMS o di cambiare browser. 

 
Apparirà a questo punto il Menù Principale, nella cui parte superiore è possibile accedere (come se si 
stessero vedendo i links in una homepage) a tutte le sezioni disponibili:  
 Preview (Anteprima) 
 PlayBack(Riproduzione) 
 Picture(Immagine) 
 Configuration (Configurazione) 
 Logout (Disconnettersi) 
Cliccando sulla sezione desiderata, nello spazio della homepage appariranno tutti i settaggi relativi alla 
configurazione della sezione scelta, oppure si apriranno tutta una serie di sottosezioni tra cui scegliere prima 
di avere accesso alla pagina di configurazione vera e propria. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://ip/
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Preview(Anteprima) 

 

Nell’identificativo canale l’icona [ ] indica l’utilizzo del main stream, mentre l’icona [ ] indica l’utilizzo del 
sub stream. Qui è possibile cambiare lo streaming utilizzato (main, sub Selezionare un canale (contorno 
giallo) per controllarne zoom e movimento (se al canale è connessa una camera con tali caratteristiche).  
Cliccando 2 volte il tasto sinistro la finestra occupa l’intera area adibita alla visualizzazione e torna alla modalità 
multiview. 
Nella parte inferiore: 

 [ ]: Permette di scegliere il numero di canali visualizzati. 

  [ / / ]: Riproduzione flussi video, Chiusura dei flussi video, Full Screen (tasto destro per 
tornare alla modalità finestra). 

  [ ]: Cattura Immagine, Registrazione (scritta REC in rosso nella finestra) e 
Zoom. In Configuration->Local Config è possibile impostare la cartella dove tali file verranno 
salvati. 
 

PLAYBACK(Riproduzione) 
È possibile riprodurre, o scaricare, quanto salvato sull’HDD dell’NVR. Si veda la sezione analoga del capitolo 
precedente. 
 
PICTURE(Immagine) 
È possibile visualizzare le immagini, o scaricare, salvate sull’HDD dell’NVR. Si veda la sezione analoga del 
capitolo precedente. 
 
CONFIGURATION(Configurazione) 
 
Channel->Camera 
È possibile editare, rimuovere, configurare ed aggiungere le camere IP all’NVR. Si veda il capitolo precedente. 
Nella sezione PoE Power Configuration è possibile visualizzare il consumo delle camere POE connesse. 
 
Channel->OSD 
È possibile attivare la visualizzazione oraria/data e la visualizzazione di una stringa per ognuno dei 16 canali 
e selezionarne la posizione. 
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Channel->Image 
È possibile impostare, per ogni camera, le impostazioni. Camere ONVIF potrebbero supportare parzialmente 
questa funzionalità. Si invita ad una configurazione diretta via WEB. 
 
Channel->Privacy Mask 
È possibile impostare, per ognuno dei 16 canali, sino a 3 maschere di copertura. 
 
Channel->Channel name 
È possibile digitare il nome da assegnare ad ognuno dei 16 canali. 
 
Storage->Record 
È possibile impostare le policy di registrazione. 
In Encode è possibile configurare lo streaming primario e secondario della camera IP. 
 
Storage-> Storage Device 
È possibile formattare o visualizzare lo stato dell’HDD installato. 
Nella sezione Cloud Storage è possibile attivare Google Drive. 
 
System->General 
Questa sezione include tutte le sezioni già ampiamente trattate nella precedente parte di questo manuale. Si 
faccia riferimento a queste per avere maggiori dettagli. 
 
 
Maintenance->Device 
Verranno mostrate informazioni circa la versione di FW installate nell’NVR. 
 
Maintenance->LOG 
È possibile visualizzare o esportare i log registrati nell’NVR. 
 
Maintenance->Manual Upgrade 
È possibile effettuare l’upgrade del FW installato nell’NVR. 
 
Maintenance->Auto Maintain 
È possibile impostare il riavvio automatico del dispositivo. 
 
Maintenance->Default 
È possibile effettuare un ripristino completo delle condizioni iniziali (Restore Factory Setting) o solo parziale 
cliccando sull’apposito bottone. 
 
 
LOGOUT(Disconnettersi) 
Cliccare per uscire dall'interfaccia web di configurazione. 
 
 

 

Browser 
Storage->Record->Encode è possibile selezionare il Main-Stream e Sub-Stream 
(risoluzione, Bitrate, FPS, Qualità). Il Sub-Stream è utilizzato per la visualizzazione LIVE 
sia locale che remota. 
È opportuno che l’upload (lato NVR) ed il Download (lato Browser/CMS) siano entrambe 
maggiori, almeno del 20%, della somma dei bitstream dei canali che si intendono 
visualizzare assieme (nel caso di multiview). 
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Il throughput in scrittura dall’NVR alla periferica può arrivare a 40/50Mbps, dipende dalle 
condizioni operative dell'NVR. 

Playback 
È possibile avere accesso a tutti i file registrati nell'hard disk dell'NVR e copiarli sull’HDD 
locale [Local Config]. 
Impostare il mese/anno/giorno nella finestra con la data (alto a destra). In File Type 
scegliere il tipo di file (Record, Motion), evidenziare il canale (alto a sinistra) e cliccare 

su Search [ ]. 
Nella parte Bassa verranno mostrate, se presente, gli intervalli temporali in cui è presente 
una registrazione. Il rosso indica una registrazione su movimento, il blu una registrazione 
su schedulazione temporale. 
Cliccare su PLAY per iniziare la riproduzione. Cliccare e mantenere premuto il tasto 
sinistro per scorrere la barra delle registrazioni. 
È possibile passare alla riproduzione, moviola/ avanzamento veloce [

]. 

Cliccare su Remote Download [ ], per accedere alla finestra di scaricamento. 
Spuntare il FILE da scaricare e premere su download (Remote Download). 
Via Browser un massimo di 4 canali per volta possono essere riprodotti. 
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6. RISOLUZIONE DEI PROBLEMI E SUPPORTO 

Questo capitolo illustra come identificare e risolvere eventuali problemi riscontrati con l’utilizzo del dispositivo 
(si suppone l'utilizzo della lingua Inglese nel menu). 
Come funziona l’applicazione BitVision per il controllo remoto dell’NVR? 

Situazione Soluzione 

Come funziona 
l’applicazione 
BitVision per il 
controllo remoto 
dell’NVR? 

 Anzitutto scaricare l’applicazione digitando BitVision  dal Play Store o App 
Store. 

 Creare un Account. 
 A questo account possono essere associati sino a 8 NVR della gamma. 
 L’NVR non può essere associato a nessun altro account. 
 Per l’accesso, da altri smartphone, è possibile condividere le credenziali di 

accesso del profilo (cui sono connessi i vari NVR). 
 L’accesso Diretto(Direct) è sempre possibile benché l’APP non offra tutta la 

versatilità di controllo offerta in modalità previo Login (creazione di account). 
Questo richiede alcune competenze informatiche (ed un IP pubblico). 

6.1 LIMITAZIONI DELL’ACCESSO 

Come posso rendere sicuro l’accesso all'NVR? 

Situazione Soluzione 

Accesso locale 
diretto all'NVR 

L'utente di default (non modificabile) è admin e la password è atlantis. Questo 
utente ha l'accesso totale al dispositivo. La password può essere cambiata. 

Gli utenti creati sono utilizzabili per permettere l'accesso diretto, WEB o APP 
(ammesso che la profilazione lo preveda). 

 
Non riesco ad entrare nell'NVR perché non ricordo alcuna password di accesso, cosa posso fare? 

Situazione Soluzione 

Il Login fallisce      
(non ricordo più                
la password di 
accesso)? 

Non esiste una password generale che permette l'accesso.  
Consultare l’assistenza tecnica. 
Non esiste alcun modo per la recovery della password se non la spedizione in 
assistenza con intervento INTERAMENTE a carico del cliente. 

 

6.2 PROBLEMATICHE E DOMANDI VARIE 

Problematiche durante l'avvio? 

Situazione Soluzione 

L'NVR non 
effettua il boot 
correttamente o si 
blocca durante 
l’utilizzo. 

 Verificare che l'alimentatore funzioni e sia correttamente connesso. 
Verificare che l'alimentazione sia presente ed adatta. Utilizzare un gruppo di 
continuità (almeno con AVR) al fine di limitare le oscillazioni del voltaggio 
presenti sulla linea di alimentazione. 

 L'HDD danneggiato può portare al blocco del boot. Provare a rimuoverlo e a 
effettuare nuovamente il boot. 

 l'NVR spesso effettua dei reboot o si blocca. Questo è indice di un'alimentazione 
non adatta, utilizzare un gruppo di continuità (almeno con AVR) al fine di limitare 
le oscillazioni del voltaggio presenti sulla linea di alimentazione. 

 Verificare che il disco rigido abbia passato il test Smart. 
 Verificare la temperatura di funzionamento e cercare di favorire lo smaltimento 

termico. 
 Forti interferenze elettromagnetiche possono causare problemi di stabilità. 

Cercare di rimuovere queste cause. 
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L'NVR non rileva l’HDD, cosa posso fare? 

Situazione Soluzione 

L'NVR non rileva 
l’HDD, cosa posso 
fare? 

Verificare che i cavi siano correttamente collegati. 
Verificare utilizzando un altro HDD di un differente produttore. 
L’HDD va formattato, alla prima installazione. 
Verificare che il cavo di alimentazione sia connesso correttamente. 
Saltuariamente capita che alcuni HDD non siano rilevati, è una situazione piuttosto 
anomala ma non escludibile a priori. 
Se l'HDD è già preformattato con una partizione Linux è opportuno procedere alla 
formattazione in NTFS/FAT32 tramite un PC e poi riprovare. 

 
L'NVR non mostra alcun video a schermo, cosa posso fare? 

Situazione Soluzione 

L'NVR non mostra 
alcun video a 
schermo, cosa 
posso fare? 
 

Verificare che i cavi siano correttamente collegati all'NVR ed alle Telecamere. 
Verificare che le Camere IP siano saldamente connesse ai cavi di alimentazione. 
Verificare che il Monitor sia saldamente connesso ai cavi di alimentazione e 
VGA/HDMI. 
Verificare che il Monitor sia saldamente connesso ai cavi di alimentazione e 
verificare che l'NVR lavori in modalità PAL. 
Verificare che la risoluzione selezionata sia supportata dal monitor. 

 
Quanto a lungo posso conservare i video registrati? 

Situazione Soluzione 

Per quanti giorni 
posso conservare i 
video ripresi? 
 

L’utilizzo di dispositivi in grado di catturare immagini, video o voce potrebbero 
essere regolamentati o completamente proibiti in talune giurisdizioni. Potrebbe 
essere richiesta un’autorizzazione. 
Atlantis non garantisce in alcun modo che i propri prodotti siano utilizzati in 
conformità con le leggi locali ed inoltre non può essere ritenuta responsabile per 
un uso improprio di tali dispositivi. 
È opportuno inoltre segnalare chiaramente la presenza di dispositivi capaci di 
catturare immagini, video. La registrazione AUDIO è sempre vietata. 
Si ricorda infine di rispettare attentamente la legislazione vigente riguardante le 
modalità di conservazione dei contenuti video ripresi. A tal fine è opportuno, salvo 
nuove normative a cui si invita ad attenersi, utilizzare i seguenti settaggi: 
 System->Record Days=1 days. 

 
Internet Explorer non riesce a visualizzare il flusso video. Cosa posso fare? 

Situazione Soluzione 

Internet Explorer 
non riesce a 
visualizzare il 
flusso video. 

Il problema dovrebbe essere generato da versioni incongruenti di OCX. È 
sufficiente forzare la rimozione di questi moduli e riavviare poi IE. 
Il dispositivo, permette la visualizzazione di flussi video esclusivamente tramite 
active X. In Windows 10 (Edge) utilizzare la modalità Apri con Internet 

Explorer, dal menù impostazioni [ ]. 
Utilizzare il CMS. 
Non sono supportati altri Browser. 

 
 
Il cicalino dell'NVR suona continuamente, cosa posso fare? 

Situazione Soluzione 

Il cicalino dell'NVR 
suona 
continuamente, 
cosa posso fare? 

Le condizioni che possono far suonare il cicalino sono molteplici, tra cui Motion 
Detection, Sensor, HDD Loss, HDD Space e Video Loss.  



  

50 

Anzitutto disabilitare il buzzer in tutti gli eventi che potrebbero attivarlo. System-
>Event->Normal Event->Motion Detection/Video Loss/Alarm 
Input/Exception. 

 
Problemi di Backup? 

Situazione Soluzione 

Il Backup non 
viene effettuato 
correttamente, 
cosa posso fare? 

Formattare preventivamente la periferica di backup in FAT 32. 
Verificare che tale periferica sia funzionante. 
Il volume collegato è troppo grande/non supportato, provare con una periferica 
diversa. 
Il File da copiare è più grande dello spazio libero nella periferica. 

 
I video presentano scatti? 

Situazione Soluzione 

I video presentano 
scatti in 
riproduzione/live, 
cosa posso fare? 

In genere questo è un problema derivante dall'eccesso di risorse necessarie per 
gestire i flussi video. A seconda della CPU integrata la potenza computazionale 
cambia. Al momento la classe di apparati offre il seguente throughtput massimo 
(somma algebrica del bitrate dei singoli canali Mani+Sub Stream) in Mbps. 
Si suggerisce di utilizzare 3Mbps per il main Stream e 512Kbps per il subStream. 
Verificare che non ci siano colli di bottiglia verso le camere IP Onvif dovuti ad 
un'infrastruttura di rete satura. 
NVR1608P-AK supportano al massimo 120Mbps (somma di tutti i canali IP 
connessi, mainstream e substream). 

 
Accesso Remoto all'NVR con Mobile. 

Situazione Soluzione 

Per effettuare un 
accesso remoto 
operare nella 
seguente modalità: 
 

Prima di iniziare è opportuno sapere che l'NVR può essere remotamente 
controllato da APP (ma anche CMS/Browser) tramite 2 differenti modalità 
operative: 
 P2P (QR Code): Viene utilizzato un server esterno. Questa modalità non 

richiede alcuna configurazione di altri apparati di rete. È necessario scansionare 
il QRCode, unico per apparato, per poter accedere all'NVR da remoto senza 
alcuna configurazione di altri apparati di rete. Consigliata. 

 IP[Direct]: Si accede direttamente, in modo tradizionale, all'indirizzo (nome) 
IP del Router (su cui vanno girate le opportune porte, 554 in TCP). Questa 
modalità è più veloce ma richiede qualche conoscenza di networking.  

 
In caso di problemi, verificare i punti seguenti (P2P): 
 L'NVR deve essere collegato, via LAN ad un dispositivo capace di offrire 

connettività verso internet (normalmente un router ADSL/VDSL/FIBRA). 
 Scaricare ed installare sul proprio dispositivo l’applicazione BitVision. 
 Entrare nell'interfaccia dell'NVR, effettuare il Login e cliccare su Main 

Menu[Menu]->System[Sistema]->Network->Advanced e poi su P2P. 
Verrà mostrato un codice QR. Spuntare la voce Enable P2P. Verificare che, 
dopo una decina di secondi,  la voce Status[Stato] sia Online. 

 Lanciare sul dispositivo Android/Apple l’applicazione BitVision. Seguire la 
sezione nel capitolo 3.3. 
 

Verificare i punti seguenti (Direct): 
 L'NVR deve essere collegato, via LAN ad un dispositivo capace di offrire 

connettività verso internet (normalmente un router ADSL/VDSL/FIBRA). 
 La password di accesso di default è la stessa usata per l'accesso tramite mouse 

(admin, atlantis). 
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 In Main Menu[Menu]->System[Sistema]->Network-
>IP/Port[IP/Porta] è possibile conoscere l’IP assegnato all'NVR (nel campo 
IP Address/Indirizzo IP).  È opportuno assegnare un indirizzo IP statico 
compatibile con la propria rete LAN. 

 In RTSP Port [Porta RTSP] e Private Port modificare secondo le proprie 
esigenze ed annotare tali valori. Il valore di default è 554/6000. 

 Accedere al Router responsabile della connettività e creare 2 Virtual Server sull’IP 
statico assegnato all'NVR per il numero di porte di sopra (RTSP Port/Private 
Port) in TCP. 

 Scaricare ed installare sul proprio dispositivo l’applicazione BitVision. Seguire 
la sezione Accesso Diretto nel capitolo 3.3. 

 
Dove trovo il CMS e la manualistica aggiornata? 

Situazione Soluzione 

Dove trovo il CMS 
e la manualistica 
aggiornata? 
 

Sul sito WEB www.atlantis-land,com alla pagina di prodotto. 
Il CMS è un software, in ambiente Window, che permette di gestire camere Onvif 
e tutti gli NVR della famiglia UltraPlex da un’unica piattaforma. 
La versione attualmente disponibile è: VMSLite(Sept 
2019)(V9.2.37.4)[Windows8-10]. 

 
Accesso locale tramite CMS? 

Situazione Soluzione 

Accesso locale 
tramite CMS. Lanciare il VMS, cliccare su DEVICE/DISPOSITIVO [ ] per aggiungere camere 

ONVIF o apparati NVR Ultraplex al VMS. 
Cliccare su Refresh/Ricaricare per effettuare la scansione degli apparati connessi 
alla LAN. Il sistema effettuerà una rilevazione dei protocolli Onvif ed UltraPlex. 
Dopo qualche secondo verranno visualizzati tutti i dispositivi rilevati. 
Spuntare il dispositivo (o i dispositivi) da aggiungere e cliccare su Add 
to/Aggiungere a. 
Digitare in User/Password le credenziali di accesso e cliccare su Next 
Step/Passo Successivo. Il VMS effettuerà una prova di connessione e visualizzerà 
il risultato in Status (Connection OK/Collegamento OK) indica che il VMS è in 
grado di controllare il dispositivo). Cliccare su Add/Aggiungi per terminare.  
Ripetere l’operazione per aggiungere nuovi dispositivi al VMS. 
Ulteriori informazioni sono disponibili nel manuale dedicato al VMS reperibile sul sito 
alla pagina di prodotto. 

 
Accesso Remoto all'NVR con Browser e/o CMS basato su Indirizzo IP (Dynamic DNS). 

Situazione Soluzione 

Per effettuare un 
accesso remoto 
operare nella 
seguente modalità: 
 

Prima di iniziare è opportuno sapere che l'NVR può essere remotamente 
controllato da CMS/Browser. Seguire i passaggi seguenti:  
 L'NVR deve essere collegato, via LAN ad un dispositivo capace di offrire 

connettività verso internet (normalmente un router ADSL). 
 La password di accesso di default è la stessa usata per l'accesso tramite 

mouse (admin, atlantis). 
 In Main Menu[Menu]->System[Sistema]->Network-

>IP/Port[IP/Porta] è possibile conoscere l’IP assegnato all'NVR (nel 
campo IP Address/Indirizzo IP).  È opportuno assegnare un indirizzo IP 
statico compatibile con la propria rete LAN. 

 In TCP port, RTSP port, http Port modificare secondo le proprie esigenze 
ed annotare tali valori. I valori di default sono 80, 554, 5000 e 6000. 

http://www.atlantis-land,com/
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 Accedere al Router responsabile della connettività e creare 3 Virtual Server 
TCP sull’IP statico assegnato all'NVR per i numeri di porte di sopra. 

 [Browser IE]: Accedere col browser all’indirizzo pubblico del router*(se si 
è cambiato HTTP Port con un numero di porta diverso da 80 digitare quanto 
segue: http://IP Router: HTTP Port) e premere il tasto invio. Alla prima 
installazione potrebbe rendersi necessario installare alcuni componenti Active 
X (su IE).  Cliccare su Submit. Si ricorda che Il dispositivo, permette la 
visualizzazione di flussi video esclusivamente tramite active X. In Windows 
10 (Edge) utilizzare la modalità Apri con Internet Explorer, dal menù 

impostazioni [ ]. 
 
E’ possibile aggiungere un NVR  Ultraplex seguendo la modalità soto riportata: 
 Cliccare su Aggiungi(Add)  e digitare in Aggiungi dispositivi 

Hardware(Add hardware devices) l’indirizzo IP WAN pubblico cui è 
connesso l’NVR (con 3 VS verso l’IP privato su cui è posizionato l’NVR delle 2 
porte TCP: 5000/6000, 80, 554) , le credenziali di accesso, selezionare 
Protocol= Ultraplex NVR(Ultraplex) o Ultraplex IPC o Onvif o Auto (secondo 
il dispositivo) e digitare poi il numero di canali. Cliccare su Passo 
Successivo(Next Step).  Il VMS verificherà la connessione e mostrerà 
collegamento OK. Cliccare su Aggiungi. 

 
Ulteriori informazioni sono disponibili nel manuale dedicato al VMS reperibile sul 
sito alla pagina di prodotto. 

 
Ho dimenticato la password dell’account (su BitVision) cui ho connesso un NVR. Cosa faccio? 

Situazione Soluzione 

Come recuperare la 
password di accesso 
 

Seguire i passaggi seguenti:  
 Lanciare sul dispositivo Android/Apple l’applicazione BitVision. 
 Toccare su Forgot, digitare la mail dell’account di cui si è dimenticata la 

password e toccare su Next. 
 Il server provvederà all’invio di una mail contenente il codice di verifica. 
In caso di problemi contattare l’assistenza tecnica. 

  
La IP Camera Onvif non viene riconosciuta e/o il video non viene visualizzato. Cosa faccio? 

Situazione Soluzione 

La IP Camera 
Onvif non viene 
riconosciuta e/o il 
video non viene 
visualizzato. Cosa 
faccio? 
 

Ultraplex NVR  supporta il protocollo Onvif 2.4. Questo lo rende interoperabile con 
una vasta gamma di apparati Onvif. Purtroppo non è insolito che si presentino 
problemi di compatibilità parziale (motion) o totale (video). 
In questo caso seguire gli step seguenti: 
 Spostare la IP Camera sulla rete dell’NVR. 
 In Channel->Camera, passare alla modalità elenco (icona in alto a destra), 

cliccare su Edit, a fianco della camera IP di cui si desidera modificare le 
impostazioni e verificare le credenziali di accesso/Indirizzo IP/Porta. 

Se il risultato è comunque negativo provare ad importare il flusso video usando il 
protocollo RTSP. 
 In Channel->Camera, passare alla modalità elenco (icona in alto a destra), 

cliccare su Add. Manually. Scegliere Protocol=RTSP, digitare 
username/password e le 2 path di accesso (da chiedere necessariamente al 
produttore della IP Camera).  Provare queste 2 path di accesso tramite VLC 
(media->Apri Flusso di rete) per verificarne la correttezza. 

http://ip/
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6.3  SUPPORTO OFFERTO 

Per qualunque altro problema o dubbio sul funzionamento del prodotto, è possibile contattare il servizio di 
assistenza tecnica Atlantis tramite l’apertura di un ticket on-line sul portale http://www.atlantis-
land.com/ita/supporto.php. Nel caso non fosse possibile l’accesso al portale di supporto, è altresì possibile 
richiedere assistenza telefonica al numero 02/ 93.55.00.66 (consultare il sito per verificare gli orari in cui il 
servizio viene erogato).   

Per esporre eventuali richieste di supporto prevendita o richieste di contatto, si invita ad utilizzare gli indirizzi 
mail info@atlantis-land.com oppure prevendite@atlantis-land.com.  

Atlantis  
via C. Chiesa 21 
Pogliano Milanese (MI) 

Fax: +39.02.84.16.00.19 

Website: http://www.atlantis-land.com Email: info@atlantis-land.com 

 
 
 
 

 

http://www.atlantis-land.com/ita/supporto.php
http://www.atlantis-land.com/ita/supporto.php
mailto:info@atlantis-land.com
mailto:prevendite@atlantis-land.com
http://www.atlantis-land.com/
mailto:info@atlantis-land.com
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APPENDICE A: CAMERE IP ATLANTIS, ONVIF ed RTSP 

 
Le IP Camere Atlantis supportate dai dispositivi della famiglia A11-NVR160X sono le seguenti: 
 A11-UX825A-BP 
 A11-UX825A-DP 
 A11-UX825A-BPV 
 A11-UX826A-BP 
 A11-UX826A-DP 
 A11-UX826A-BPV 
 A11-UX914A-BP 
 A11-UX914A-DP 
 A11-UX915A-BP 
 A11-UX915A-DP 
 A11-UX915A-BPVM 
 Tutte le camere IP Facile tramite ONVIF. Si noti che questi dispositivi non possono essere alimentate via 

PoE in quanto supportano solo lo standard PoE mode A mentre A11-NVR1608P-AK supporta solo lo 
standard PoE mode B. 

 

 

In talune camere Onvif la preview potrebbe essere non visualizzata. In questo caso è 
opportuno forzare la preview.  
Effettuare il Login, poi andare su Canale->Ricerca [Channel->Search]. Il dispositivo 
effettuerà la ricerca di camere IP (eventualmente cliccare su Search).  
Spuntare le camere da aggiungere, toccando su +.  
Cliccare nel campo Cambia [Edit] della camera di cui si desidera forzare alcuni 
parametri.  

È possibile anche aggiungere una telecamera ONVIF che non risulta 
configurabile/compatibile in modalità RTSP. Introdurre adesso in Main/Sub le path RTSP 
(vanno richieste al fornitore della IP Camera). 
In RTSP sostanzialmente si ha accesso al solo flusso video e tutte le altre funzionalità 
non sono supportate (movimento se PTZ, rilevazione movimento, maschera etc). 
Accedere in Canale->Agg. Manuale. 
Spuntare la voce Abilita, selezionare in Canale il numero di canale cui assegnare il 
dispositivo, Protocollo=RTSP, immettere le credenziali di accessi, in Main mettere la 
path di accesso allo streaming principale (rtsp://IPCamera:554/00) in SUB mettere 
la path di accesso al substream (rtsp://IPCamera:554/01). 
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APPENDICE B: CONTATTI ATTIVI 

 
A11-NVR1600-AK offre avanzate funzioni di commutazione che rendono possibili la ricezione/invio di segnali 
ad altri dispositivi di allarme (rilevatori volumetrici, PIR o sirene). 
Si veda nel disegno seguente uno schema di installazione tipico. 

 
Come si può vedere il dispositivo integra, nella parte posteriore: 
 [ALARM IN] 4 ingressi programmabili (G,G,1,2,3,4) 
 [ALARM OUT] 4 PIN per la connessione verso una sirena/dispositivo esterna alimentata (G,4)/ (G,3)/ 

(G,3)/ (G,1) 

 

Nell’esempio sopra sono stati installati: 
2 sensori in ingresso sulle porte Alarm IN 4 ed 1. 
2 sirene in uscita sulle porte Alarm OUT 4 ed 1. 

Prestare la massima attenzione durante il cablaggio, un cattivo cablaggio 
può portare alla rottura della board di controllo invalidando la garanzia. 
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SIRENA(ALARM OUT) 
In sostanza è possibile collegare a questi PIN il circuito controllato (dotato di alimentazione propria). Si veda 
lo schema nella figura precedente. 
Gli eventi responsabili della chiusura del circuito sono: 
 Trigger dovuto al cambio di stato di un sensore (Alarm IN) 
 Video Loss 
 Motion Detection 
 Exception 
 Trigger manuale (nella pagina Alarm OUT) 

 

La corrente massima permessa è di 500mA/12VDC. Valori superiori possono 
danneggiare irrimediabilmente la board di controllo (cambiamento di stato 
del Trigger) invalidando la garanzia. 

Prestare la massima attenzione durante il cablaggio, un cattivo cablaggio 
può portare alla rottura della board di controllo invalidando la garanzia. 

 
 
SENSORI ESTERNI (ALARM IN) 
4 sensori esterni possono essere collegati al dispositivo. Si veda lo schema nella figura precedente. 
Possono cambiare lo stato del circuito in ingresso facendo scattare un trigger capace di controllare: 
 Segnalazione a Video 
 Sirena (attivazione allarme in uscita) 
 Cicalino Interno (suona ad intermittenza sino a che il sensore ALARM IN resta chiuso, quando 

viene nuovamente aperto la segnalazione acustica viene interrotta dopo il tempo di delay 
impostato) 

 Invio Mail 
 Registrazione video (canali configurati in Alarm) 

 

 

Il circuito Alarm IN viene considerato attivato dall’NVR solo quando diventa 
un circuito chiuso, quando lo stato impostato sull’ingresso è NO, o il contrario 
se lo stato è impostato su NC. 
Si veda lo schema precedente. 

È opportuno inserire almeno una fascia oraria, mentre il giorno della 
settimana è ignorato (pertanto la rilevazione dell’ingresso è fatta, 
indipendentemente dal giorno, nelle 2 fasce orarie definite). 

Per effettuare la Registrazione su Allarme. 
 Storage->Record attivare la programmazione in ALARM (rosso) sul canale 

desiderato. 
 System->Normal Event->Alarm Input configurare il sensore in Alarm IN e 

attivarlo e poi in Linkage Action->Channel Record attivare il canale che dovrà 
essere registrato. 
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APPENDICE C: IP Camera tramite RTSP 

Protocollo RTSP nelle IP Camera della famiglia A11-UX 
RTSP (Real Time Streaming Protocol) è un protocollo utilizzato per l’invio di video da server a client remoti. È 
supportato da molti client quali VLC ed altri. Con questo protocollo è possibile utilizzare le IP Camera della 
famiglia A11-UX su altri NVR e/o SW specifici. 

 

Accesso diretto IP Camera 
Dai vari client RTSP è possibile accedere al flusso video Main Stream digitando: 
RTSP://IPcam:554/0 
Dai vari client RTSP è possibile accedere al flusso video Sub Stream digitando: 
RTSP://IPcam:554/1 
 

Accesso diretto NVR 
È inoltre possibile accedere direttamente ai flussi in RTSP sull’NVR cambiando il canale 
opportuno. Ad esempio il comando seguente RTSP://IPNVR:554/XX0 o 
RTSP://IPNVR:554/XX1 permette di accedere al main stream/Substream del canale 
XX (il canale parte da 0). 
RTSP://IPNVR:554/100 (main stream del canale 11) 
RTSP://IPNVR:554/01 (substream del canale 1) 
Si raccomanda di selezionare Video Type=Video  (in Channel Setting->Channel 
parameters->Recording Parameters) al fine di evitare problematiche durante la 
visualizzazione dei flussi RTSP. 
 

[VLC] In caso di problemi nella visualizzazione, si aconsiglia di utilizzare il sw VLC.  
Accedere in Strumenti->Preferenze->Ingresso/Codificatori e spuntare la voce 
RTP su RTSP(TCP). 

 
Configurazione di VLC MediaPlayer (su Computer): 

 Avviare il MediaPlayer VLC (versione provata 2.1.2) e selezionare la voce Apri flusso di rete dal menu 
Media. 

 Selezionare la voce RTSP in protocollo, ed impostare nel campo Indirizzo come segue (sostituendo 
l’indirizzo IP presente nella stringa con quello della Camera da visualizzare). Fare attenzione a che la porta 
sia identica a quella utilizzata in Config->Network Parameters->Network Settings->RTSP Port. 
Cliccare su Riproduci per iniziare lo streaming del video. 
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Configurazione di VLC MediaPlayer (su Android): 

 Avviare il MediaPlayer VLC (versione provata 0.9.10) e cliccare sull’icona [ ] e digitare poi la path 
(RTSP://IPNVR:554/ch01.264). Cliccare poi su Open.
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APPENDIX D: TECHNICAL SPECS 

Technical Specs 

Code A11-NVR1600-AK 

Version V21.0 

Product Name NVR 1600 AK 

Video Channel Supported 16 x 8MP@400FPS 

Max Throughput Max 100mbps 

Chipset  Fullhan MC6830 

Video Output  1 x HDMI (up to 3840x2160) 
 1 x VGA  (Monitor) (up to 1920x1080) 

Audio Input 1 RCA (Not Supported) 

Audio Output 1 RCA (Not Supported) 

PTZ Only by LAN (RS485 isn’t supported) 

Sensor IN/Out 4/4 

Storage 1 x 3,5" (or 2.5”) SATA1/2 (up to 4TB) 

Other Connectors  RJ-45 for Ethernet 10/100/1000 Mbps   
 2 x USB 2.0 (mouse and external storage pheripherals) 
 DC power jack (12,0VDC 2,0A max 24W) 

LAN Ports 1 Gigabit Ethernet 

Housing Aluminium 

Video System PAL 

Video Compression H.264 / H.265 

FPS 8MP (3840x2160) Recording/Playback 400/25FPS (max 100 Mbps) 

FPS 5MP (2592x1944) Recording/Playback 400/25FPS (max 100 Mbps) 

FPS 2MP (1920x1080) Recording/Playback 400/10FPS (max 100 Mbps) 

Audio Codec 8Khz, 16 Bit ADPCM 

Event (Action)  Motion Detection (Buzzer, Record, Mail/FTP, Alarm*) 
 HDD/Broken Network (Buzzer, Mail, Screen) 

Recording Mode  Always 
 Schedule 

 Alarm Detection (Motion) 
 Alarm 

 Manual 

Security 1 x Admin, Nx Users (with different level) 

GUI Language English, Italian 

Advanced Networking  DynDNS, No-IP, Oray etc 

 P2P (using QR code the customer can remotely control 
the device without any configuration) 

Browser (Configuration) IE (Active X), FireFox, Chrome, Edge  

Browser (Live View) IE (Active X) 

SmartPhone Android/IOS (BitVision App) 

Backup  USB Flash Memory/HDD (FAT/FAT32) 

 Network (Browser IE or CMS) 

Certifications CE (Europe) 

Dimensions  (WxHxD) 260x230x45 (with base support) mm 

Weight 770g 

Temperature Range  Operation: 0°C ~ 32°C 

 Storage: -10°C ~ 60°C 

Humidity 20% ~ 80% (non Condensing) 

Power Adapter  Input:100-240VAC, 50/60Hz, 0,7A Max 

Output:12,0VDC / 2,0A/ 24,0W Max      [ ] 

System Requirements (only for WEB 

configuration).  

 TCP/IP protocol must be installed on each PC 

 Web browser, such as Microsoft Internet Explorer 6.0 
or later (Active X), Edge/Chrome/FireFox. Live View 

Only on IE with PlugIn. 
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 CPU:Intel Celeron CPU E3400 @2.6GHZ or above 
 Graphic Card: 64 MB RAM graphic cards(or equivalent 

on-board graphic cards) 
 Windows  7, 8 (32/64), 10 

NVR CMS   Support connection to 16 NVRs at most and 64 
channels video simultaneously 

 Support visit of any video channel of different NVRs 

and screen dragging and random combination 
 Support remote recording playback and backup 

 Support off-line playing and smooth playing of backup 
video 

 Support remote parameters configuration 

 Support remote control of PTZ 
 Support local capture and recording 

 Support screen lock 
 Compatible with all UltraPlex (IP Camera and  NVR)  

and IP Facile Camera 

NVR CMS  System Requirements  Windows  7, 8 (32/64), 10 
 Microsoft .Net Framework 3.5 and Microsoft Visual 

C++2010 X86 Redistribuable Setup 
 CPU: Intel Celeron CPU E3400 @2.6GHZ or above 

 Multimedia: above DirectX 9.0; 
 Recommended internal memory: above 4 GB. 

 Gigabit Card 

Package Contents  NVR  

 Multilanguage Quick Start Guide (English, Italian) 
 USB Mouse  
 Adapter AC-DC (12V@2,0A) 

 Warranty Card 

EAN Code 8026974022178 

 
 
 
 

Tutti i marchi riportati sono registrati ed appartengono ai rispettivi proprietari.  

Microsoft e Windows sono marchi registrati di Microsoft Corporation. 
Mac OS X è un trademark di Apple Inc. 
Le specifiche riportate possono cambiare senza preavviso. Nessuna responsabilità per errori e/o omissioni. 

Le condizioni ambientali e di utilizzo possono pesantemente influenzare il throughput atteso. 
L’utilizzo di dispositivi in grado di catturare immagini, video o voce potrebbero essere regolamentati o completamente proibiti 

in talune giurisdizioni. Potrebbe essere richiesta un’autorizzazione. 
Atlantis non garantisce in alcun modo che i propri prodotti siano utilizzati in conformità con le leggi locali ed inoltre non può 
essere ritenuta responsabile per un uso improprio di tali dispositivi. 

Il disco rigido non è incluso. Un disco SATA è richiesto per salvare i dati. Questo prodotto potrebbe non funzionare con vecchie 
generazioni di dischi SATA.  
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